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About This User’s Manual

This manual provides detailed instructions on how to set up, use, and maintain Atrust mt168L mobile thin clients.

Manual Structure and Subjects

Chapter Subject
1 Provides an overview of Atrust mt168L mobile thin clients.
2 Provides detailed instructions on how to set up Atrust mt168L mobile thin clients.
3 Provides the basics of how to use Atrust mt168L mobile thin clients.
4 Provides instructions on how to configure client settings and customize Atrust mt168L

mobile thin clients with the Atrust Client Setup console.

Provides supplementary instructions on advanced settings, maintenance, and upgrade for

Appendices Atrust mt168L mobile thin clients.

Specifications Provides detailed information on key components of Atrust mt168L mobile thin clients.

Notes, Tips, and Warnings

Throughout this manual, the notes, tips, and warnings in the following formats are used to provide important
information, useful advice, and prevent injuries to you, damage to your devices, or loss of data on your system.

NOTE

(alll |

« A note provides important information for a specific situation.

TIP

74

- Atip gives a piece of useful advice to perform a task more efficiently.

@ WARNING

« A warning provides crucial information that must be followed to prevent injuries to
you, damage to your devices, or loss of data on your system.



Style Conventions

The following styles are used throughout this manual while referring to operational items on input devices,
hardware panels, or application interfaces.

Item
keys on the keyboard

application windows or
entry lists

buttons or tabs on a
window, toolbars, taskbar,
or menu

options on a window,
screen, list, or menu

selecting a series of options

Style
bold
first letter

capitalized

bold

bold

bold

Example
Ctrl + F2, Alt + F9, Alt + Tab
Confirm Dialog window, RDP Connection list, ICA Connection list,

View Connection list

OK, Next, Save, Applications tab

Add, Domain, Connection Type, High Quality

Applications > Citrix ICA, Applications > Remote Desktop,
Applications > VMware View, Network > Wireless,
Devices > Printer, System > Time Zone



Safety and Regulatory Information

Regulatory Statement

Federal Communications Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of the following measures:

« Reorient or relocate the receiving antenna.
« Increase the separation between the equipment and receiver.
« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate this equipment. This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20 cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.



Regulatory Information

WEEE (Waste Electrical and Electronic Equipment) Directive
In the European Union, this symbol indicates that this product should not be disposed of with
household waste. It should be deposited at an appropriate facility to enable recovery and recycling. For
mmm  proper disposal, please contact your local recycling or hazardous waste center.

Safety Information

@ WARNING

+ Use only power supplies listed in the user instructions.

@ WARNING

- Danger of explosion if battery is incorrectly replaced. Replace only with the same or
equivalent type recommended by the manufacturer.

@ WARNING

- For safety, do not make mechanical or electrical modifications to the equipment.

- Do not remove equipment covers and access any of the components inside the
equipment. Any access inside the equipment without an authorized or certified
technician may cause serious injuries and damage. For any problem, contact your
dealer for assistance.

+ You should only make repairs as authorized by the product documentation.
Repairs, replacement, expansion, and upgrades not performed by a certified service
technician may cause injuries to you, damage your system, and void your warranty.
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Overview

This chapter provides an overview of Atrust mt168L.
1.1 Introduction
Desktop virtualization and simple endpoint devices

1.2 Features
Key features of Atrust mt168L

1.3 Package Contents
Check your package contents

1.4 Exterior Views
Exterior design of Atrust mt168L

1.5 Exterior Components
Exterior components of Atrust mt168L






Overview
Introduction

1.1 Introduction

Desktop virtualization provides a new perspective to reconsider the design and implementation of an IT
infrastructure. In a desktop virtualization infrastructure, a station is no longer a cumbersome desktop, but simply
an endpoint device for users to access delivery services from the server(s).

With the introduction of the desktop virtualization technologies, you can considerably benefit from:

« On-demand applications/desktops

« Centralized management of work environments

« Drastically reduced endpoint software/hardware issues

«  Simplified system maintenance and improved system security

+  More scalability with low-cost endpoint devices

1.2 Features

The key features of Atrust mt168L mobile thin clients are:

«  Built-in Wireless 802.11 a/b/g/n and Ethernet network interface
«  Support for a wide range of desktop virtualization solutions from industry-leading companies:
o Microsoft® Remote Desktop
o Citrix® XenApp™, XenDesktop®, and VDI-in-a-Box™
o VMware® View™ and Horizon View™
+  Support for high-definition technologies
o Microsoft® RemoteFX®
o Citrix® HDX™
o VMware® View™ PColP®
- Simple click-access to various applications/desktops

«  Built-in Atrust Client Setup as the local client management console

1.3 Package Contents

Please check your package contents. Ensure that all of the items are present in your package. If any items are
missing or damaged, please contact your dealer immediately.

Atrust mt168L AC adapter Battery

NOTE: Your package may not contain a hard copy of the Quick Start Guide.
In this case, a soft copy in PDF format will be provided.

3
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1.4 Exterior Views

Front View

Left View Right View

Bottom View and Battery




1.5 Exterior Components

Display and Base Components

Overview
Exterior Components

\?\

©
|
2

No. Sign Component Description
1 LCD display Built-in display for visual output.
2 Microphone Built-in microphone for audio input.
3 Webcam (optional) Built-in video camera for real-time video.
4 Keyboard Built-in keyboard for control and input.
s () powerbutn B e e e LeD).
6 Touchpad Built-in pointing device for control and input.
7 Speaker Built-in speakers for audio output.

5
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No. Sign Component Description

8 GB Bluetooth LED Glows blue when Bluetooth is enabled (not supported).
9 x Wi-Fi LED Glows blue when Wi-Fi is enabled.

10 k Sleep Mode LED Glows orange when the system is in Sleep mode.

:

12 8 Storage LED Glows blue when flash memory is being accessed.

13 Num Lock LED Glows blue when Num Lock is enabled.

14 Caps Lock LED Glows blue when Caps Lock is enabled.

15 Scroll Lock LED Glows blue when Scroll Lock is enabled.
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Fn Key Combinations

With the combination of Fn B plus another specific key (with one printed blue symbol on it), you can quickly
adjust hardware settings to suit your needs.

N
Esc Fl F2 F3 F4 F5 F6 F7 F8 Fo F10 F11 F12 PriScr | | Pause Ins Del
=y 2 P1 = ) > 2 ) | SysRq | | Breck | |NumLk | | Scrlk
~ | @ # $ % A & 7 * 8 (9 )/ - + Backspace He
lome
N 1 2 3 4 5 €]|6 7 8 9 0 - =
- Q w E R T Y U 4|1 5O 6||P =] |{ } |
% Tab PgUp
[ 1 \
Caps Lock <! Enter PgDn
— — H '
0 < > ? 0+
A shift z X c v B N M A shifr 4 End
/ W o
|
crl Fn = Alt AltGr =l Crl -« v -»>
\ 1) v )
J

NOTE

« To use an Fn key combination, press and hold Fn, and then press another key.

Combination Description Combination Description
Use to enable / disable Num Lock mode.
| +12 .| Use to switch the use of displays. o | Num Lock Mode: switches specific keys

to enter digits and symbols. See table
below for details.

Use to enable / disable Scroll Lock mode.

by your model.

= |+|™ ) Use to enable / disable the touchpad. o |+ Scroll Lock Mode: allows to scroll
E— — through the screen with arrow keys.

o o[ Use to define the custom action. S I Use to increase the brightness of

PIJ" This is not supported by your model. ¢ the LCD display.
o[ Use to enable / disable the ECO mode. A Use to decrease the brightness of
n = n 4 .

ECO Mode: Screen Off mode the LCD display.

- This combination is not supported I Use to decrease the volume of

the built-in speakers.

Use to enable / disable the Flight mode.
Flight Mode: disabled wireless module

Use to increase the volume of
the built-in speakers.

+
2 3
N Y 1©

F12

+

Use to enter the System Sleep mode.

Press the Power button or any key on the
keyboard to exit.

End
o

Use to mute / unmute the sound.

Digits and Symbols in Num Lock Mode

Description

Mol|l) 1]|K 2[|L 3||U 4 ) . .
‘ ‘ _ ‘ ‘ Use to type in the desired digit or symbol (blue one on the key).
‘ I 5 ‘O & 7| * 8| 9 NOTE: You must enable the Num Lock mode first.
7 8 9
- - NOTE: To customize Num Lock mode, please see “4.3.7 Adjusting
)/ P = B 7?7 + > .
o ‘ ‘ ) ‘ / ‘ Keyboard Settings” on page 84.
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Left and Right Side Components

No. Sign Component Description

16 === DC IN Connects to an AC adapter.

17 O VGA port Connects to an external display.

18 SS=% USB port (USB 3.0) Connects to a USB device.

19 Q Headphone port Connects to a set of headphones or a speaker system.
20 @ Microphone port Connects to a microphone.

21 e USB port (USB 2.0) Connects to a USB device.

22 SD card slot (optional) Reads/Writes data from a SD card.

23 E LAN port Connects to a network.

24 Kensington security slot Connects a Kensington cable to secure the mobile thin client.




Bottom Components

Overview
Exterior Components

7 \ ” ] D7)
|
‘ % —— =
No. Sign Component Description
25 Lithium-ion battery Supplies the moblle thln_ client with the power when an external
power source is not available.
Unlocks the battery by sliding and holding left.
P .

26 RELEASE Left battery latch NOTE: To remove the battery, use the right battery latch to
unlock the battery, and then slide left and hold this latch
to remove the battery.

Locks / Unlocks the battery by sliding left / right.
27 UNLOCK Right battery latch NOTE: To remove the battery, use this latch to unlock the

battery, and then slide left and hold the left battery latch
to remove the battery.

9
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Setting Up Your mt168L

This chapter provides detailed instructions on how to set up
your mt168L mobile thin client.

2.1 About the AC Adapter
Information on the use of the AC adapter 13

2.2 Charging Your Lithium-ion Battery

How to charge your lithium-ion battery 13
(Recommended for first time use)

2.3 Setting Up Your mt168L
How to set up your mt168L 14






Setting Up Your mt168L
About the AC Adapter

2.1 About the AC Adapter

To use the supplied AC adapter, please do the following:

1. Unpack your mt168L package, and then take out the AC adapter and its detached power cord.

2. Attach the power cord to the AC adapter to assemble your AC adapter.
2.2 Charging Your Lithium-ion Battery

=}) NOTE
7
« For the first time use, it's recommended to charge your Lithium-ion battery first.

To charge your lithium-ion battery, please do the following:

1. Slide the battery into the battery compartment until it clicks into place, and then Slide left the right battery

latch to lock the battery securely.

Slide left completely to
ensure the battery is
securely locked.

Attach the DC plug of the AC adapter to your mt168L, and then connect the AC plug of the adapter
to a power outlet.

3. The Battery LED glows orange while the battery is being charged.
4. On completion, the Battery LED glows blue.

13



14| Setting Up Your mt168L
Setting Up Your mt168L

2.3 Setting Up Your mt168L
To set up your mt168L, please do the following:

1. Use the AC adapter or the Lithium-ion battery as the power source:

+ To use the AC adapter, attach its DC plug to your mt168L, and connect its AC plug to a power outlet.

« To use the Lithium-ion battery, slide it into the battery compartment until it clicks into place, and then
slide left the right battery latch to lock the battery securely.

”

ok

Slide left completely to
ensure the battery is
securely locked.

2. Connect the LAN port to your local network with an Ethernet cable or set up a wireless connection later (see
“Topic 2: Setting Up a Wireless Connection” on page 20).



Getting Started

This chapter provides the basics of how to use your mt168L.

3.1 Learning the Basics

Topic 1:
Topic 2:
Topic 3:
Topic 4:
Topic 5:
Topic 6:

Atrust Quick Connection

Setting Up a Wireless Connection
Configuring the Time Zone

Accessing Desktops or Applications
Using Built-in Applications

Viewing and Managing the Use of Power

18
20
22
23
37
39






Getting Started
Learning the Basics

3.1 Learning the Basics

The following topics will guide you through the basics of using your mt168L:

Topic 1:
Topic 2:
Topic 3:
Topic 4:

Topic 5:

Atrust Quick Connection

Setting Up a Wireless Connection

Configuring the Time Zone

Accessing Desktops or Applications

«  Microsoft Remote Desktop Services (RDP sessions)

«  Citrix Services (ICA sessions)
« VMware View or Horizon View Services (View sessions)

Using Built-in Applications

Topic 6: Viewing and Managing the Use of Power

=) NOTE
7
« In case that by default your mt168L is Auto Setup enabled, its user environment
might be different from here and will vary with preset configurations. See section
4.2.9 and appendix A.4, and consult your IT administrator for details.
=) NOTE
7

« Three client modes are available for your mt168L:

No. Mode Description

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection o0 after system startup.

+ In Quick Connection mode, you can access Microsoft Remote Desktop / Citrix /
VMware View or Horizon View services quickly without much client configuration
required. The main purpose of this chapter is to guide you through the use of your
mt168L under the Quick Connection mode. The default of your mt168L is NOT the
Quick Connection mode (after restart it will enter the local Linux desktop rather
than Atrust Quick Connection screen), but you can enter Atrust Quick Connection
screen through its shortcut on the local desktop or START menu.

+ To understand other modes, configure advanced settings, and customize your
mt168L, please refer to chapter 4 “Configuring Client Settings” on page 41.

17
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Learning the Basics

Topic 1: Atrust Quick Connection

To start using your mt168L, please do the following:

1. Press the Power button to turn on the client. Wait a moment for the system to enter the local Linux desktop.

Local Linux Desktop

o

Atrust Qui

%

Atrust

L’[ L4 [Terminal - user@atrust | us 'g’ « ﬁ (=} ‘ 11:19

2. Click Atrust Quick Connection on the desktop to enter Atrust Quick Connection screen.

i
|

Atrust Quick Connection

Atrust

L’[ il [Terminal - user@atrust | us g < H= ‘ 11:19




Getting Started
Learning the Basics

3. (a) Go to Topic 2 to set up a wireless connection if needed.
(b) Go to Topic 3 to set the time zone for the first time use.
(c) Go to Topic 4 for service access if the time zone had been set.

Atrust Quick Connection Screen

- Remote Desktop

Citrix

Atrust Quick Connection

"% Remote Desktop

.I B VMware View

| Citrix

B VMware View

Atrust

4 5 6

No. Icon

Description

1 Power Off

Click to shut down, suspend, or restart the system.

2 Local Desktop Click to return to the local Linux desktop.
3 Setup Click to launch Atrust Client Setup.
4 Mixer Click to configure audio settings.
Indicates the power source (adapter, battery, or both) and status.
Click to launch Power Management for details.
NOTE: Power Management enables you to configure power-saving settings for your
mt168L. You can choose appropriate options to suit your needs. See “Topic 6:
Viewing and Managing the Use of Power” on page 39 for details.
5 Power

NOTE: When your mt168L enters System Sleep mode manually (Fn + F12 or

@ > Suspend) or automatically (configured in Atrust Client Setup through
System > Power Management), it still requires a certain amount of power.

You can use Shut down option instead to save the power to a greater degree.

NOTE: When using only the battery as the power source, ensure that it has enough
power to prevent data loss.

6 Network

Indicates the network type (wired or wireless) and status.
Click to configure network settings.

NOTE: To set up a wireless connection, please see "Topic 2: Setting Up a Wireless
Connection” on page 20.

19



20| Getting Started

Learning the Basics

Topic 2: Setting Up a Wireless Connection

To set up a wireless connection, please do the following:

1. On Atrust Quick Connection screen, click the Network ig icon. Atrust Client Setup is launched.

®H Atrust Client Setup | =N [ N=TN |
Atrust Applications  User Interface Derices Nemork System
Navigator General
Ethernet
-~ Hosts ¢ Interface .
Host Name ‘ . ¥ Enable ‘
~oWireless L
Proxy ¢ IP Address )
‘ IP Type: bR -1 ‘
- DNS <
‘ DNS Type: Dynamic DNS (via DHCP) hd i ‘
| Save H Cancel

2. Click Wireless. The Wireless Network list will be shown under the Connections sub-tab.

®H Atrust Client Setup | E=E el B
Atrust Applications User Interface Devices Newiork System
Connections Wireless
- Ethernet
- Hosts + Add - Delete Ol scan
- Host Name
"E‘ess SSID Signal ~ Security  Status Comment

e T-APO2 100 WPA
SMCWGBR14S-N 100 WPA
Beatles 100 WPA
TP-LINK_F36B08 88 WPA
WMR_AP 88 WPA
HTC Portable Hotspot AAFS 88 WPA
dir810-2g 87 WPA
AndroidAP3104 85 WPA
Mike - HTC D620 75 WPA
test-88 74 WPA
Amphenol PM 72 WPA
dlink "2.4" GG 71 WEP
DSR-1000N 71 WPA
Amphenol Sale 70 WPA
WEP110 87 WEP
IT-APOL 67 WPA
test56 62 WPA
dir810-5g Bl WPA
IT-APO3 58 WPA
BUFFALO-E7B7DC_G 58 Insecure
dlink0l 57 WEP
dlink "5.0" GG 55 WPA
BUFFALO-E7B7DC_A 51 Insecure
EDIMAX 50 WPA

%J‘ NOTE

+ Your mt168L will perform network discovery once and specify all available wireless
networks in the Wireless Network list under the Connections sub-tab. To refresh this

Wireless Network list, click O;f;, 5can  on the top of the list.

3. Click to check the desired wireless network. The Connect button / Connect = then appears on the top of the
Wireless Network list.



Atrust

Navigator

- Ethernet
~Hosts
Host Name
Wireless
- Proxy

Getting Started
Learning the Basics

o S T | ~ (| [ B
H Atrust Client Setup A E=RIE B
Applications  User Interface Devices Nework System
Connections Wireless

+ Add = Delete O scan  # connect
SSID Signal “  Security Status Comment

' IT-APO2 100 WPA
SMCWGBR14S-N 100 WPA
Beatles 100 WPA
TP-LINK_F36B08 88 WPA
WMR_AP 88 WPA
HTC Portable Hotspot AAFE 88 WPA
dir-810-2g 87 WPA
AndroidAP3104 85 WPA
Mike - HTC D620 75 WPA
test-88 74 WPA
Amphenol PM 72 WPA
dlink "2.4" GG 71 WEP
DSR-1000N 71 WPA
Amphenol Sale 70 WPA
WEP110 67 WEP
IT-APOL 87 WPA
tests6 62 WPA
dir-810-5g 61 WPA
IT-APO3 58 WPA
BUFFALO-E7B7DC_G S8 Insecure
dlink01 57 WEP
dlink "5.0" GG 55 WPA
BUFFALO-E7B7DC_A 51 Insecure
EDIMAX 50 WPA

4. Click # Connect to create a wireless network connection through the selected wireless network.

5. A window appears prompting for confirmation or authentication.

NOTE

N

Wireless Network Authentication Required

Authentication required by wireless network. Passwords or encryption
keys are required to access the wireless network.

[WPa & wPA2 Personal

| J

Wireless Security:

Key

Show character

- If you ever accessed this wireless network before, the password will be automatically
recorded for future access. In this case, you don’t need to provide the password
again; you only need to confirm the establishment of a wireless connection.

« Consult your network administrator for required information on authentication.

6. Type in the required password, and then click Connect to continue. Or, click OK to confirm the establishment
of a wireless connection.

Upon completion, the Status column of the wireless network will show connected.

SSID Signal * Security Status Comment
SIT-dlink 70 WPA
Apple Networ... 62 WPA
AsUS 60 WPA
HTC jess 59 WPA
t55 54 WPA
_IT-APO1 54 WPA
{IT-APO2 53 WPA connected Connected before
Tenda_545F38 53 WPA

8. Close Atrust Client Setup.
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Learning the Basics

Topic 3: Configuring the Time Zone

To set the time zone for your mt168L, please do the following:
1. Click the Setup @ icon to launch Atrust Client Setup.

Atrust Client Setup

® Atrust Client Setup il LOLILS

Category Tabs
Click a tab to select
a setting category.

Atrust Applications  User Interface Devices Nework System

Remote Desktop

Navigation Area ——————— citrixica = Remote Deskup Avallable Sessions: O
- VMware View &4 configure ROP (Remote Desktop Protocol) connection settings
Click to select - ssH
. . PeN) Citrix ICA Available Sessions: 0
a Settlng Item Configure Citrix ICA connection settings

or entry. -
[+ VMware View Ayailable Sessions: 0

s configure ViMware View connection settings

SSH Available Sessions: 0
Configure SSH (Secure Shell) session settings

5/ NOTE

« For detailed instructions on how to configure client settings and customize your
mt168L with Atrust Client Setup, please refer to chapter 4 “Configuring Client
Settings” on page 41.

2. On Atrust Client Setup, click System > Time Zone.

® Atrust Client Setup

System

Atrust Applications  User Interface Derices Nemwork System
| Time ZOE ’ Navigator General
g Time Zone
- Password ¢ Time Zone N
Fmuars Update || Time zon i
- Appliance Mode L - ] Time Zone
- Auto Setup _
-~ Quick Connection ||  MTP . drop-down menu
~Terminal | NTP Server Address # [poolntp.org [
= Daport L ]
‘e Manager
Save [ save || cancel
\_I

3. Click the Time Zone drop-down menu to select the desired time zone.

4. Click Save to apply, and then close Atrust Client Setup.
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Topic 4: Accessing Desktops or Applications

Through Atrust Quick Connection screen, you can access three types of desktop virtualization services:
Remote Desktop, Citrix, and VMware View.

Atrust Quick Connection Screen
= Remote Desktop

Citrix

Atrust Quick Connection

emote Desktop

v B VMware View

® | Citrix

é B VMware View

Atrust

=

Icon Description Page
Remote Desktop Click to access Microsoft Remote Desktop services. 24
Citrix Click to access Citrix XenApp, XenDesktop, or VDI-in-a-Box services. 25

VMware View Click to access VMware View or Horizon View services. 34
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Accessing Microsoft Remote Desktop Services

To access Microsoft Remote Desktop services, please do the following:

(Walls'q i Remote Deskiop on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the appeared window, type in the computer name or IP address of the server, user name, password, and
domain (if any), and then click Connect.

~

d

Session name: <Quick Connection: 'I
MR- ]
WMS

Remote Destkop
Connection

___ To return to the previous screen, press Esc.
) Use Alt + Tab to select and restore a hidden or minimized
~  application or deskiop session.

—=)) NOTE

Ll

« To discover available Windows MultiPoint Server systems over your network,
please do the following:

ey
1. Click we™ on the left of the Computer field.
2. Upon completion, a window appears with the search result.

Confirm Dialog

Windows MultiPeint Servers' list, please select one that you
want to connect:

|EE-SV1 (192.168.11.108) ﬂ

3. Click the drop-down menu to select the desired system, and then click OK.
4. The IP address of the selected system will appear in the Computer field.

» To return to Atrust Quick Connection screen (see the screen in Topic 4), press Esc.

3. The remote desktop will be displayed on the screen.
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Accessing Citrix Services

Connecting to the Server

To connect to the server through which Citrix services are accessible, please do the following:

1. Click on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the appeared Atrust Citrix Connection screen, enter the appropriate IP address / URL / FQDN of the server,
and then click Log On.

Atrust Citrix Connection Screen

Citrix Receiver

NOTE

(alll |

- For newer versions of XenDesktop and XenApp, you may need to further specify
the sub-path of the server. Refer to the following table for details:

Component to

Citrix Product Connect

Connection Address

XenApp 6.5 or

earlier Web Interface IP / URL / FQDN

XenDesktop 5.6

or earlier Web Interface IP / URL / FQDN

IP / URL / FQDN plus sub-path

For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenApp and
XenDesktop 7.5

+ FQDN is the acronym of Fully Qualified Domain Name.

- To return to Atrust Quick Connection screen (see the screen in Topic 4), press Esc.

25
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Logging On to Citrix Services

When connected to the server, the Citrix Logon screen appears. The appeared screen and required credentials for
Citrix services may vary with the service type and version.

@ NOTE

« A warning message “This Connection is Untrusted” might appear. Consult the
IT administrator for details and ensure the connection is secure first. To import
a security certificate, please refer to section “4.2.16 Importing Certificates for
Remote Computers” on page 71.To bypass, click | Understand the Risks > Add
Exception > Confirm Security Exception.

The following are some examples of Citrix Logon screens.
XenDesktop 5.6 Platinum:
Citrix Logon Screen

Citrix XenDesktop

Type the required
user name, password,
and then click

Log On to access
virtual desktops.

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet

CITRIX" (0%

@ NOTE

«+ To return to Atrust Quick Connection screen, press Esc.



Getting Started
Learning the Basics

XenApp 6.0 Fundamentals:

Citrix Logon Screen

Type the required

user name, password,
domain, and then click
Log On to access
virtual applications.

NOTE

(]

+ To return to Atrust Quick Connection screen, press Esc.

- If your XenApp server doesn’t belong to any domain, type the computer name of
the server in the Domain field.

XenApp 6.5 Platinum:

Citrix Logon Screen

Citrix XenApp

Type the required

user name, password,
domain, and then click
Log On to access
virtual applications.

Logon

e
s I
-

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

cimRix (=2

NOTE

Wl

« Toreturn to Atrust Quick Connection screen, press Esc.

« If your XenApp server doesn’t belong to any domain, type the computer name of
the server in the Domain field.

27
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VDI-in-a-Box:

Citrix Logon Screen

Type the required user
name, paSSWOrd, Citrix Receiver

and then click

Log On to access
virtual desktops.

NOTE

ol

+ To return to Atrust Quick Connection screen, press Esc.

XenApp and XenDesktop 7.5 Platinum:

Citrix Logon Screen

Type the required user CitrixReceiver
name, password,

and then click

Log On to access
virtual desktops.

NOTE

[l

« Toreturn to Atrust Quick Connection screen, press Esc.
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Accessing Virtual Desktops and Applications

You will enter the Desktop Selection or Application Selection screen after logon. On the screen you can click to select
the desired desktop or application(s).

5’/ NOTE

+ You might enter the virtual desktop directly if only one type of virtual desktop is
assigned to the provided credentials.

TIP

« Use Alt + Tab to select and restore a hidden or minimized application or desktop.

@

The following are some examples of Selection screens and delivered desktops and applications.
XenDesktop 5.6 Platinum:

1. The Desktop Selection screen appears after logon.

Desktop Selection Screen

& cmx

Setings Log

2. Click to select the desired desktop.

3. The selected virtual desktop will be displayed on the screen.



30| Getting Started

Learning the Basics

Virtual Desktop Example: Windows 7 Ultimate

) Wecometoyou i HenDeskiop

Welcome to the virtual workstyle

Your desktop, jocuments at your fingertips
urv ine freedom t0 do whatever, wheneve

—w
20 a4

XenApp 6.5 Platinum:

1. The Application Selection screen appears after logon.

Application Selection Screen

—— S8 cmpe

2. Click to select the desired application(s).

3. The selected application(s) will be displayed on the screen.
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Virtual Application Examples
PowerPoint Viewer, Adobe Reader, and Notepad

Open a Recent File Acrobat.com Services

TR cresepor onine

i/ NOTE

« Clicking on Application Selection screen will bring the screen to the front and leave
all launched application windows hidden behind. Use Alt + Tab to select and restore

a hidden or minimized application window.

+ Exiting a virtual desktop or application will return to the Desktop Selection or
Application Selection screen. On the screen, you can:

< Click to launch another virtual desktop if any or to launch other applications.
<~ Click Log Off on the top of the screen to return to the Citrix Logon screen.
< Press Esc to return to Atrust Quick Connection screen directly.

XenApp and XenDesktop 7.5 Platinum:

1. The Application Selection / Desktop Selection screen appears after logon.

Application Selection Screen

31
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You might see this
screen when you log
in to XenApp 7.5 for
first time. Just click
to add your favorite

apps from a list. Al ADD YOUR

~ || FAVORITE APPS}

Desktops

— Two buttons may be available
for your to switch between
Application and Desktop
Selection screen, depending on
your server-side deployment.

Desktop Selection Screen

2. Click to select the desired application(s) or desktop.

3. The selected application(s) or desktop will be displayed on the screen.
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Virtual Desktop Example: Windows Server 2008 R2

Virtual Application Examples
Adobe Reader, Mozilla Firefox, and PowerPoint Viewer

vecmas §) 8 12 5 11 5

=) NOTE

« Clicking on Application Selection screen will bring the screen to the front and leave
all launched application windows hidden behind. Use Alt + Tab to select and restore
a hidden or minimized application window.

« Exiting a virtual desktop or application will return to the Desktop Selection or
Application Selection screen. On the screen, you can:

<~ Click to launch another virtual desktop if any or to launch other applications.
< Click Log Off on the top of the screen to return to the Citrix Logon screen.
< Press Esc to return to Atrust Quick Connection screen directly.

33
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Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Click on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the opened window, double-click Add Server icon or click New Server in the top-left corner. A window
appears prompting for the name or IP address of the VMware View Connection Server.
3. Enter the required information, and then click Connect.

P N
_le Connecl

VMware Horizon Client

File Connection View Help

+ New Server

+ New Server

Add Server

Enter the name of the Connection Server,

|

annec_t |

Add Server

NOTE

- To return to Atrust Quick Connection screen (see the screen in Topic 4), close the
opened window.

=

4. A Welcome window might appear, click OK to continue.

5. A window appears prompting for the credentials. Enter your user name, password, click the Domain
drop-down menu to select the domain, and then click OK.

Server Login

vmware Horizon

Server: (@ bitps:/AMCSVHV.poc

Username: |\ |

Password: | |

Domain: |‘u’H\f | A4 |

Cancel | |
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@‘/ NOTE

« A window might appear with a certificate message about the remote server.
Consult the IT administrator for details and ensure the connection is secure first.

To import a security certificate, please refer to section “4.2.16 Importing Certificates
for Remote Computers” on page 71.To bypass, click Connect Insecurely.

6. The Desktop and Application list appears with available desktops and/or applications for the provided
credentials. Double click to select the desired desktop or application.

VMware Horizon Client

Eile Connection View Help

ErR| e | N
&Y [ HitpsIMVTS VHVipoT

Adobe Reader X| Caleulator

a g0 =

Notepad Paint Skype

7. The virtual desktop or application will be displayed on the screen.

Virtual Desktop Example
Windows 7 Ultimate

File v Connection~ View v Help~ | (0 @ X
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Virtual Application Examples (VMware Horizon 6 with View)

LINE, Adobe Reader, Mozilla Firefox, and Calculator

[® VMuware Horizon Cllent File > Connection v View» Help~ | 0 @ &

LINE

B My Computer..

B2 Acobstom

Recent Files | View All

Login QR Code Login
Login

B8 fdebeResder EEmE

Fle Gt View Window Hep

Do | QB2 B S| ®0]0| o]k Tools | Fill &Sign | Comment

R cemeror

@ sttt
B cetvocmrs s
&) Sorevouriesonine

Adobe Online Services

‘Adobe ExportPDF
Comvert PDFfles to Word or Excel
oniine.

Google

Select POF Fil:
Let the world know you #Chooselndependent
with Firefox.

ConvertTo:
Microsoft Word (*do0) -

Recognize Tetin Engish(U:
e SR

* O

History

0

Syme Options

&

Bookmarks

(R

Search

@ Restore revous sef| ===

a

-s

NOTE

- Your desktop or application will be displayed in full screen. You can:

< Click File > Return to Desktop and Application List on the top tool bar to
recall the Desktop and Application list.

VMware Horizen Client

File = | Connection ¥ View~ Help~ | (@ @ X

4r Disconnect from Server...

\ Return to Desktop and Application List

wf Preferences

o Quit

< Click View on the top tool bar to switch to a virtual desktop or application.

VYMware Horizen Client File + Cennection »

VW] e~ | O @ ®

) Windowed

Resize

® Full Screen - This Monitor
C Full Screen - All Monitors

Adobe Reader
@ Firefox
QO LNE

= W7U

[ Windows Calculator
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Topic 5: Using Built-in Applications

To use built-in applications (Web browser, PDF viewer, LibreOffice, etc), please do the following:

%J’ NOTE

- The access shortcuts for built-in applications may be hidden by default. You need to
enable the display of those shortcuts on the desktop and START menu first.

1. Enable the display of application shortcuts on the local desktop and START menu.
1) On the local desktop, click START > Settings > Atrust Client Setup to launch Atrust Client Setup.
2) On Atrust Client Setup, click User Interface > Desktop.

® Atrust Client Setup callc LU LSS

Atrust Applications  User Interface Devices

z
:
i

System
General

- System Language -
Language: English

r

Screensaver This setting will take effect after reboot.

( Desktop Fonts
Default Font:

Default Font Style: Regular

Default Font Size:

Title Font:

]| [~ w
B |~ )
£ 5
Ol L e ‘

remiree

Title Font Style: Regular

Title Font Size:

o
1

 Desktop lcons
[ | | Remote Desktop

[ Cirix
[
[ ¥ Firefox Web Browser
Libreoffice
PDF Viewer (Document Viewer) =

VMware View

=

save || Cancel

3) Click to check LibreOffice and PDF Viewer, and then click Save to apply.

Atrust Client Setup

Atrust Applications ~ User Interface Devices Nemwork System
Navigator General
“Displa -
Dasktop - System Language §
Keyboard Language: ]
i Mouse
L Screensaver This setting will take effect after reboot
 Desktop Fonts ———————— «(\Ware View
Default Font
efault Font stle ' Firefox Web Browser
Default Font Size:
Title Font +| LibreOffice

Title Font Style:
Title Font Size:

v PDF Wiewer (Document Vie

- Desktop lcons
[ [ Remote Desktop
Citrixc

Cancel

=

L [ VMware View

[ v Firefox Web Browser
L ¥ Lbreoffice

(¥ PDF Viewer (Decument Viewer)

save || cancel

4) Close Atrust Client Setup.
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2. The shortcuts appear on the local desktop and START menu.

|2 Document Viewer
@ Firefox Web Browser
[ LibreOffice

@ Atrust Quick Connection
[Accessofes b (<4 Document Viewer
P | @ Firefox Web Browser
[ LibreOffice

| |@ (Terminal - User@at... |

3. Click shortcuts on the desktop or START menu to launch applications.

Atrust

us O «less) 14:48]
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Topic 6: Viewing and Managing the Use of Power

To view and manage the use of power for your mt168L, please do the following:

1. On Atrust Quick Connection screen or on the local Linux desktop, click the Power @ icon in the
bottom-right corner to launch Power Management. Here you can view the use and settings of power.

— Power Management dallodlo

General

rinformation

Current power source :
Charge status :
Remaining battery power :

AC power
Charging
79%

rSetting

AC power saving mode: | Low

® Suspend O st down

Battery power saung mode:

Dimmed LCD: 5 minutes later
Turn off LCD: 10 minutes later
@ Suspend ) Shut down 1 hour later

You can click Adjust button to change settings.

If needed, click Adjust to launch Atrust Client Setup to configure the settings of power.

®

Atrust Client Setup o=l
Atrust Applications  User Interface Derices Network System
Navigator General
Time Zone
. Password - Power Management ,
Firmware Update AC power saving mode: -
-~ Appliance Mode
- Quick Connection
Tum off LED: Mo 10
1 Terminal Enter Suspend or Shutdown: =
Error Report
- Certificate Manager Suspend or Shutdown after (Never = Disable) e
- Advanced
Battery power saving mode: [
Dimmed LCD: 5 minutes later ]
Turn off LCD: 10 minutes later e
Enter Suspend or Shutdown: B
Suspend or Shutdown sfter (Never = Disable) 1 hour later e
Save H Cancel

3. Choose the desired power-saving mode for your AC power and battery, or choose Custom to customize
individual settings, and then click Save to apply.

=) NOTE
5 "
+ When your mt168L enters System Sleep mode manually (Fn + F12 or @ >
Suspend) or automatically (configured in Atrust Client Setup through System >
Power Management), it still requires a certain amount of power. You can use

Shut down option instead to save the power to a greater degree.

@ WARNING

« When using only the battery as the power source, ensure that it has enough power
to prevent data loss.
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Configuring Client Settings

This chapter provides instructions on how to configure advanced
settings and customize your mt168L with Atrust Client Setup.

4.1 Atrust Client Setup
Interface overview 43
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4.3 Configuring User Interface Settings
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4.6 Configuring Service Access Settings

Applications tab overview 120
Available settings at a glance 121
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Atrust Client Setup

4.1 Atrust Client Setup

Your mt168L comes with Atrust Client Setup, the built-in local client management console to help you configure
client settings and customize your mt168L.

4.1.1 Interface Overview
To access Atrust Client Setup on your mt168L, please do the following:
1. On Atrust Quick Connection screen, click the Setup @ icon to launch Atrust Client Setup.

2. The Atrust Client Setup window appears.

Interface Overview

o 6 ® O (5]

.
.
.
.

ecece
ecee
ecece
ecece

® Atrust Client Setup alloullollle s
. .

O

. .
Atl'l.lSt Applications User Interface Devices Network System

¢o Remote Desktop

Citrix ICA i) . Remote Deskwp 2vzilable Sessions: 0 R
s WMware View & Configure RDP (Remote Desktop Protocol) connection settings

Ciwix ICA fvailable Sessions: 0
Configure Citrix ICA connection settings

|+ VMware View Available Sessions: 0
— Configure VMware View connection settings

SSH Available Sessions: 0
<= Configure SSH (Secure Shell) session settings

Interface Elements

No. Name Description
1 Applications tab Click to configure settings for service access through the client.
2 User Interface tab Click to configure settings for the user interface of the client.
3 Devices tab Click to configure settings for external devices of the client.
4 Network tab Click to configure settings for the connectivity of the client to networks and servers.
5 System tab Click to configure settings for the operation and maintenance of the client.
6 Navigation area Click to select a setting item under a selected tab or to select a setting entry under

a selected setting item.

7 Configuration area Configures setting values when a setting item or entry is selected.
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4.1.2 Client Settings at a Glance

The following table provides a brief description of each setting item under five main setting categories.

Tab

System

User Interface

Devices

Network

Applications

Setting Item Section

Configuring time zone and time server
Configuring passwords

Configuring remote assistance settings
Updating firmware

Enabling/Disabling the Appliance mode
Enabling Auto Setup

Configuring Quick Connection
Managing the use of power

Enabling/Disabling the execution of the
text-based (command-line) functions

Collecting event logs, capturing related
screens, and upload files for error reporting

Importing certificates for remote computers
Enabling/Disabling Auto Registration

4.2 Configuring System Settings

Configuring display settings

Customizing desktop and system language

Hiding/Showing Quick Access shortcuts

Using a custom wallpaper 4.3 Configuring User Interface Settings
Adjusting keyboard settings

Adjusting mouse settings

Configuring screensaver settings

Configuring settings for USB storage devices
Configuring settings for audio devices 4.4 Configuring External Device Settings
Configuring settings for local/network printers

Configuring wired network settings
Configuring VPN settings

Creating the mapping of IP addresses to the
names or aliases of hosts

Creating the Failover Cluster list 4.5 Configuring Network Settings
Changing the host name of your client
Configuring wireless network settings

Configuring proxy settings for Web-based
access to services

Configuring Microsoft RDP connection settings
Configuring Citrix ICA connection settings
Configuring VMware View connection settings
Configuring SSH connection settings

4.6 Configuring Service Access Settings

Page
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4.2 Configuring System Settings

4.2.1 System Tab Overview

System tab enables you to configure settings for the operation and maintenance of clients. To access available
settings of System tab, click the tab on Atrust Client Setup.

System Tab Overview
® Atrust Client Setup Gillod LGS
AtrUSt Applications User Interface Derices Network System
eesescscedeceeTime Zone -
(1) “Time Zon p—— AR

- Firmware Update O set the time zone and time server
~Appliance Mode
Auto Setup
~Quick Connection l Password

- Power Management Configure administration privileges and remote assistance settings

~Terminal

--Erro_r_ReporT 4V Firmware Update
- Certificate Manager 2 Update firmware through the network
Advanced

@, Appliance Mode

Configure Appliance mode

E. y Auto Setup
=== Configure Auto Setup Mode

ng Quick Connection

Configure Quick Connection mode

- Power Management
Configure the Power Management

> Terminal
&L Configure the access of command-line interface

Interface Elements

No. Name Description

1 Navigation area Click to select a setting item under System tab.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4.2.2 Available Settings at a Glance

Tab Setting

Time Zone

Password

Firmware Update

Appliance Mode

Auto Setup

System

Quick Connection

Power
Management

Terminal

Error Report

Certificate
Manager

Advanced

%'/ NOTE

Icon

Ly

‘_.-j'

a Iz

]

|

¥

%

Description

Click to configure the time zone and time server for

your mt168L.

Click to configure the access privileges of Atrust
Client Setup for mt168L users.

Click to set the login password for the local desktop.

Click to configure settings for remote assistance.

Click to update firmware through the network.
This feature is applicable to the client only when

the client is managed by the remote Atrust Device

Manager console.

Click to enable/disable the Appliance mode to allow/

disallow the automatic RDP / ICA / View sessions.

In Appliance mode, the client starts up directly with
the desired RDP / ICA / View session and performs

the configured action after exiting the session.

Click to enable Auto Setup to allow the client to get

its preset configurations on startup and enter the
desired user environment automatically.

Click to configure the Quick Connection mode.

Click to manage the use of power.

Click to enable/disable the execution of the
text-based (command-line) functions.

Click to collect error log and launch the screen
capturing program for error reporting.

Click to upload files to a specified FTP server for
error reporting.

Click to import or manage certificates for
remote computers.

Click to configure advanced settings such as
Auto Registration.

« Atrust Device Manager is a remote and mass client management console,
helping you remotely manage a large number of endpoint devices in a desktop
virtualization infrastructure. For more information about Atrust Device Manager,
please refer to the User’s Manual for Atrust Device Manager.
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4.2.3 Configuring Time Zone and Time Server

On Atrust Client Setup, click System > Time Zone.

Configuring Client Settings
Configuring System Settings

The Time Zone setting allows you to configure the desired time zone and time server to get the accurate system
time for your mt168L.

To set the desired time zone and time server, please do the following:

® ENE

Atrust

- Firmware Update
- Appliance Mode
- Auto Setup

-~ Quick Connection

-~ Terminal

~Error Report

- Certificate Manager

NOTE

Atrust Client Setup o alliCS
Applications User Interface Derices Network System
General
¢ Time Zone \
‘ Time Zone: [eMT+8:00 1o ‘
« NTP
‘ NTP Server Address * |poo|.ntp.org ‘ = ‘

| Save H Cancel |

2. Under the Time Zone section, click the drop-down menu to select the desired time zone.

3. Under the NTP (Network Time Protocol) section, use the default or type in the desired time server.

« The IP address of the default time server is pool.ntp.org. For more information on
the default, please refer to the website for the NTP Pool Project at www.pool.ntp.org.

- Ensure the connectivity of your mt168L to the network or Internet in order to get

accurate time from the time server.

4. Click Save to apply.
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4.2.4 Configuring the Access Privileges and Passwords of Atrust Client Setup

You can configure the access privileges of Atrust Client Setup for mt168L users by the Password setting.

NOTE

]

+ All mt168L users are allowed to access Atrust Client Setup by factory default.
You can make changes as desired using this setting.

Setting Access Privileges and Password Only for Administrators
To set access privileges and password only for administrators, please do the following:

1. On Atrust Client Setup, click System > Password.

®) Atrust Client Setup o =llCS
Atru St Applications User Interface Devices Newwork System
Navigator General
- Time Zone
Password ¢ Administrator

Firmware Update ‘ I_ Active Admin Authorization
- Appliance Mode L

- Auto Setup i

- Quick Connection ¢ Local Desktop .
Terminal = Enable Password Authentication for Local Desktop ‘

~Error Report \

- Certificate Manager - Shadow

. ¥ Enable Shadow

Change Password

| Save H Cancel |

2. Under the Administrator section, click to check Active Admin Authorization.

3. The access privileges for administrators are granted and a window appears for you to set the password.

- - T e
® Set Password diala
Confirm Password = :]

* Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.
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Setting Access Privileges and Password Also for Standard Users
To set access privileges and password also for standard users, please do the following:

1. On Atrust Client Setup, click System > Password.

2. Under the User section, click to check Active User Authorization.

® Atrust Client Setup o alliCS
Atrust Applications User Interface Devices Network System
Navigator General
- Time Zone
Password ¢ Administrator

- Firmware Update
- Appliance Mode

I.; + Active Admin Authorization ‘

- Auto Setup Change Password
- Quick Connection L

-~ Terminal

~Error Report ( U;er

- Certificate Manager

e Active User Authorization ‘

Local Desktop
= Enable Password Authentication for Local Desktop ‘

r Shadow )
|_.‘ + Enable Shadow ‘

Change Password

| Save ] | Cancel

%J‘ NOTE

« The User section appears only when Active Admin Authorization is checked.

3. The access privileges for standard users are granted and a window appears for you to set the password.

® Set Password

Confirm Password = :]

*Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.
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4.2,5 Configuring the Login Password for the Local Desktop

To enable and set the login password for the local desktop, please do the following:

%J’ NOTE

« The default behavior is to enter the local desktop without any login password.

1. On Atrust Client Setup, click System > Password.

®) Atrust Client Setup

Atl'l.l St Applications User Interface Derices Nemork System

Navigato General

-~ Time Zone

Password ¢ Administrator )
- Firmware Update ‘ L. || Active Admin Authorization ‘
-~ Appliance Mode L

- Auto Setup
- Quick Connection ( cha\ Desktop )
- Terminal ‘ .. | Enable Password Authentication for Local Desktop ‘
~Error Report

- Certificate Manager

¢+ Shadow
.. ¥ Enable Sshadow

Change Password

| Save H Cancel J

2. Under the Local Desktop section, click to check Enable Password Authentication for Local Desktop.
A window appears for you to set the password.

® Set Password

Confirm Password = :]

*Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

3. Type in the desired password, and then click OK to confirm.
4. Click Save to apply.
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NOTE

« When this feature is enabled, each time when you start or restart your mt168L,
you will be prompted to provide the Login password for the local desktop.
The Login screen is shown as below.

Login Screen of Local Desktop

Enter your local password

Possworc:

Atrust
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4.2.,6 Configuring Shadow Settings for Remote Assistance

The Shadow feature allows an administrator to remotely assist client users in resolving problems or configuring local
settings. When this feature is enabled, an administrator can monitor and control a client from a remote computer
just like a local user.

_—%' NOTE

—

+ To use the Shadow feature on a remote computer, you need to install the Atrust
Device Manager console on that computer, and add your mt168L into a managed
group under Atrust Device Manager. For details, please refer to the User’s Manual
for Atrust Device Manager.

To enable the Shadow feature and set the password for remote assistance, please do the following:

1. On Atrust Client Setup, click System > Password.

®) Atrust Client Setup o =llCS
Atru St Applications User Interface Devices Newwork System
Navigator General
- Time Zone
Password ¢ Administrator .
Firmware Update ‘ L [ Active Admin Authorization ‘
- Appliance Mode L
- Auto Setup
- Quick Connection  Local Desktop 1
Terminal ‘ e Enable Password Authentication for Local Desktop ‘
~Error Report L
- Certificate Manager - Shadow

.. ¥ Enable Shadow

Change Password

| Save H Cancel |

2. Under the Shadow section, click to check Enable Shadow if it's not checked.

_—%' NOTE

—

«+ By default, the Shadow feature is enabled. Click Change Password, and then follow
the next step to set your password.

3. The Shadow feature is enabled and a window appears for you to set the password for remote assistance.
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o e b e
® Set Password il as

Confirm Password * :]

* Your password can contain letters, numbers, and
special characters.

* It must be 4 to 8 characters long.

NOTE

i)

- On aremote computer, an administrator will need this password to use the Shadow
feature (remote assistance) with the Atrust Device Manager console. For more
information, please refer to the User’s Manual of Atrust Device Manager.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.

NOTE

oll]

« When the Shadow feature is performed from a remote Atrust Device Manager, on

the target client, an icon appears on the Taskbar of the local Linux desktop
and a notification pops up in the bottom-right corner. If you are under the Quick
Connection mode (the default for mt168L thin clients), a notification would pop up
in the upper-left corner on Atrust Quick Connection screen.
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4.2.7 Updating Firmware from the Management Computer

Update Firmware allows client users to update firmware from its management computer.

= NOTE

=z

« Ensure that your mt168L has been added into a managed group under Atrust
Device Manager installed on a remote computer, and that you have imported client

firmware files into Atrust Device Manager. These are prerequisites of this feature.

+ For more information on firmware update and Atrust Device Manager, please refer
to the User Manual for Atrust Device Manager.

To update firmware from the management computer, please do the following:

1. On Atrust Client Setup, click System > Firmware Update.

Atrust Client Setup AR e

Atrust Applications  User Interface Derices Network System.

General

- Time Zone

- Password
Firmware Update

- Appliance Mode

- Auto Setup

uick Connection

- Terminal

~Error Report

Certificate Manager

- Firmware Update
Current Version: Ver. 5.06-INTL

Check Firmware

This setting will take effect after reboot.

Cancel

2. Under the Firmware Update section, click Check Firmware.

3. Upon completion, a window appears notifying you that the Firmware list has been loaded.

4. Click Yes to continue.

®

O

Confirm Dialog

List Loading Completed!

iy
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5. Click the drop-down menus to select the desired firmware version and other update options.

® 0 =

Atrust

- Time Zone

- Password

Firmware Update

- Appliance Mode
Auto Setup
- Quick Connection
- Terminal

~Error Report

Certificate Manager

Atrust Client Setup AR e

Applications User Interface Dervices Network Syseem

General

- Firmware Update
Current Version: Ver. 5.06-INTL

Firmware Version: |ATRUSTL\NUX 5.07-PREC hd

Language: | English hd il T
Reboot Immediat ely: [Mo -l o
Keep the User Data: [vES | =

Check Firmware

This setting will take effect after reboot,

Update ﬁrmwarel ‘ Cancel

Firmware Update Options

Item

Description

Firmware Version

Click to select the desired firmware version.

Language

Click to select the interface language of the system, including the
Atrust Client Setup console.

NOTE: Available languages may vary with the selected firmware version.

Reboot Immediately

Click to choose whether to restart the system immediately for firmware update
or manually restart the system later.

Keep the User Data

Click to choose if to keep the setting values under Atrust Client Setup.

NOTE: If Yes is selected, all setting values under Atrust Client Setup will remain
unchanged after firmware update.
If No is selected, all setting values will be restored to the factory default.
This option may not be available on your system.
NOTE: If the client is managed by Atrust Device Manager and here No is
selected, Atrust Device Manager will fail to manage the client after
firmware update. For more information on Atrust Device Manager, please
refer to the User’s Manual for Atrust Device Manager.

6. Click Update firmware to confirm your selections. The system will start updating its firmware after restart.
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4.2.8 Enabling or Disabling the Appliance Mode

The Appliance mode allows your mt168L to start up directly with the desired Microsoft Remote Desktop, Citrix ICA,
VMware View or Horizon View session. Under this mode, users will feel as if they were using a standalone desktop
computer; the underlying client operating system, Atrust Linux, is hidden from the very beginning.

NOTE

« There are three similar but different modes for your mt168L and only one mode
will take effect if all are enabled. Three modes and the order of priority are listed
as follows:

5/

No. Mode Description

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop
e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection 0o after system startup.

« For more information on these modes, please refer to sections:

< 4.2.10 on page 60 and 3.1 on page 17 (Quick Connection mode)
4.2.8 on page 56 (Appliance mode)

4.6.5 on page 137 (Autostart mode for RDP sessions)

4.6.11 on page 175 (Autostart mode for ICA sessions)

4.6.14 on page 208 (Autostart mode for View sessions)

R
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Enabling the Appliance Mode
To enable the Appliance mode, please do the following:

S NOTE
- Ensure that you have configured the connection settings for the desired Microsoft
Remote Desktop, Citrix ICA, VMware View or Horizon View session under
Applications tab. You need to specify which service type and connection settings
entry will be used under the Appliance mode. For detailed instructions, please see

sections:
< "4.6.3 Configuring Basic RDP Connection Settings” on page 122

< "4.6.6 Configuring Basic ICA Connection Settings”on page 152
< "4.6.12 Configuring Basic VMware View Connection Settings” on page 204

NOTE
« Please note that the Autostart mode also enables the client to start up directly with
an RDP / ICA / View session and provides more configuration flexibility than the
Appliance mode. For detailed information on the Autostart mode, please refer to

the following sections:
< “4.6.5 Configuring Advanced RDP Connection Settings” on page 137
< "“4.6.11 Configuring Advanced ICA Connection Settings” on page 175
< "4.6.14 Configuring Advanced View Connection Settings” on page 208

i)

1. On Atrust Client Setup, click System > Appliance Mode.

®) Atrust Client Setup wlolol
Atl'l.l St Applications User Interface Derices Network System
Time Zone
- Password r Basic Settings
~ Firmware Update Enable Appliance Mode
Appliance Mode = PP
Auto Setup b
- Quick Connection 7] ]
- Terminal | Save | | Cancel |

- Error Report
- Certificate Manager

2. Click to check Enable Appliance Mode.

57



58| Configuring Client Settings
Configuring System Settings
3. Other settings of the Appliance mode appear.

~ Basic Settings
.. ¥ Enable Appliance Mode

Application Type:

[citrix IcA -
Use Session: |XD - I-.
on Application Exit: |Shutdown - I-.
*To launch Console: Shift+ Ctri+Delete

* To minimize ICA Fullscreen Deskfop: Press Left Cirl+F2 then Alt+FS

4. Click drop-down menus to select the application (or service) type: Citrix ICA, Remote Desktop, or
VMware View, the specific service available in that type, and the desired action after exiting a session.

- Basic Settings

|_-‘ +| Enable Appliance Mode

Application Type:

[citrix ICA ~
Use Session; [xD -] o
On Application Exit: |Shutd0wn - ._
*To launch Console: Shift+ Ciri+ Delete

* To minimize ICA Rullscreen Desktop: Press Left Cirf+F2 then Alf+F%

- Basic Settings

I-. +| Enable Appliance Mode
Application Type:

[Remote Desktop -]
Use Session: [whs -l
on Application Exit: [shutdown -l

¥ To launch Console: Shift+ Ctri+ Delete

* To toggle ROP fullscreen: Ctri+Alf+Enter

~ Basic Settings
.. ¥ Enable Appliance Mode

Application Type:

|VMware View hd
Use Session: |V1—N - I-;
on Application Exit: |Shutdown - I-.
¥ o launch Console: Shift+ Ctri+Delete

* o release keyboard and mouse from the virtual desktop, press Ctri+Alt

%J’ NOTE

- No matter which Resolution option you choose for the selected RDP / ICA / View
service, RDP / ICA /View sessions under the Appliance mode will always use the
Full Screen mode to display the remote/virtual desktop.
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5. Click Save to confirm your selections.

6. The system will enter the Appliance mode after restart.

NOTE

(W]

- To disable the Appliance mode or to access Atrust Client Setup under the Appliance
mode, please refer to “Disabling the Appliance Mode” on page 59.

Disabling the Appliance Mode
To disable the Appliance mode, please do the following:

1. Under the Appliance mode, exit the Full Screen mode of the RDP / ICA session, or release the keyboard and
mouse from the View session (virtual desktop):

To exit the Full Screen mode of the RDP session, press Ctrl + Alt + Enter, and then minimize
the session window.

To exit the Full Screen mode of the ICA session, press Ctrl + F2, and then Alt + F9.

To release the keyboard and mouse from the View session (virtual desktop), press Ctrl + Alt.

NOTE

i)

+ Please note that the View session (virtual desktop) will remain on the background
after you release the keyboard and mouse from the View session (virtual desktop).

2. Click Ctrl + Shift + Del to launch Atrust Client Setup.

NOTE

(alll |

You cannot access the Taskbar of the client operating system (Atrust Linux) under
the Appliance mode.

. On Atrust Client Setup, click System > Appliance Mode.

. Click to uncheck Enable Appliance Mode, and then click Save to apply the change.
5. Return to the current RDP / ICA / View session:

- Toreturn to the current RDP / ICA session, use Alt + Tab (press and hold Alt, and then press Tab to switch

between different items) to select and restore the current RDP / ICA session.

« Toreturn to the current View session, click any place of the View session (virtual desktop)
on the background.

6. Log off from the current RDP / ICA / View session.

The client will shut down then. Restart your client manually.
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4.2,9 Enabling or Disabling Auto Setup

Auto Setup allows your thin client to get its preset configurations on startup and enter the desired user environment
automatically. Its operation requires Auto Setup environment and network connectivity, except for Auto Setup on
the client side. For details, please refer to “A.4 Auto Setup Flowchart” on page 229 and User’s Guide for Auto Setup.

NOTE

- To disable Auto Setup after your thin client got its preset configurations, reset
your client. Please refer to “A.1 Resetting Your mt168L to the Factory Default” on
page 219.

5/

4.2.10 Configuring the Quick Connection Mode

The Quick Connection mode enables you to enter the Atrust Quick Connection screen after system startup.
This setting is disabled by default for mobile thin clients.

NOTE

« For detailed instructions on how to use your mt168L under the Quick Connection
mode, please refer to section“3.1 Learning the Basics” on page 17.

5/

+ There are three similar but different modes for your mt168L and only one mode will
take effect if all are enabled. Three modes and the order of priority are
listed as follows:

No. Mode Description

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop
e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.
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NOTE

« To use the Quick Connection mode, ensure that both the Appliance and Autostart
modes are disabled. If either of two modes are enabled, the Quick Connection
mode will fail to work.

=

- For more information on the Appliance mode, please refer to section “4.2.8 Enabling
or Disabling the Appliance Mode” on page 56.

« For more information on the Autostart mode, please refer to the following sections:

< "4.6.5 Configuring Advanced RDP Connection Settings” on page 137
< "4.6.11 Configuring Advanced ICA Connection Settings” on page 175
< “4.6.14 Configuring Advanced View Connection Settings” on page 208

To enable/disable the Quick Connection mode, please do the following:

1. On Atrust Client Setup, click System > Quick Connection.

®) Atrust Client Setup o =llCS
Atru St Applications User Interface Devices Newwork System
- Time Zone
- Password - Basic Settings

Firmware Update
- Appliance Mode
- Auto Setup

Terminal

~Error Report
- Certificate Manager

e Enable Quick Connection after Power-up

Save ] | Cancel

2. Click to check/uncheck Enable Quick Connection after Power-up to enable/disable the Quick Connection
mode, and then click Save to apply the changes.

NOTE

- For advanced Quick Connection settings, please refer to the next section (4.2.11).
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4.2.11 Configuring Advanced Quick Connection Settings

You are allowed to configure advanced Quick Connection settings for Remote Desktop, Citrix ICA, and
VMware View sessions through System > Quick Connections on Atrust Client Setup.

Advanced Quick Connection Settings for Remote Desktop Sessions
To configure advanced Quick Connection settings for Remote Desktop sessions, please refer to the table below:

- Remote Desktop Option
. ¥ Multimedia Redirection

Remote Desktop Option

Item Description

Check/Uncheck to enable/disable multimedia redirection.

When enabled, the client receives original compressed multimedia streams and
decodes locally for display. This feature increases the load on the client, but
saves server resources, decreases the bandwidth usage, and improves audio and
video playback experiences.

Multimedia Redirection

It's enabled by default (when Quick Connection mode is enabled).

Advanced Quick Connection Settings for Citrix ICA Sessions
To configure advanced Quick Connection settings for Citrix ICA sessions, please refer to the tables below:

« Citrix ICA Option
.. [¥| Client Rendering

. ¥/ HDX RealTime WebCam

=4 Use H264 Compression

Citrix ICA Option

Item Description

Check/Uncheck to enable/disable client rendering.
Client Rendering
When Client Rendering is disabled, Server Rendering is used.

This item is available only when Client Rendering is selected.
HDX RealTime WebCam
When Yes is selected, a locally attached webcam can be used in an ICA session.

Check to enable H.264 compression support on the client, allowing session data

Use H264 Compression are sent from the server side using H.264 format encoding.
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ke Redirect Connected USB Devices

* All connected USB devices will be redirected unless more specific settings are
specified below,

* Enabling USB Redirection an the server side is also required for this feature.

Citrix ICA Option

Item

Description

Redirect Connected

USB Devices

Check to enable redirection for connected USB devices in Quick Connection
mode. All connected USB devices will be redirected unless more specific settings
are specified below.

UUse of USB Storage Devices: |Mapping ;l =

Use of USB Printers: [Mapping ~1 [

Citrix ICA Option

Item

Description

Use of USB Storage Devices

Click to select how to use USB storage devices in ICA sessions. Three options are
available: Mapping, Redirection, and Disabled.

Use of USB Printers Click to select how to use USB printers in ICA sessions. Three options are

available: Mapping, Redirection, and Disabled.

Plugged USE Devices: o
(Wendor; 2047 Product: 03df) Texas Instruments

Mendor: Obda Product: 0128) Realtek Semiconductor Corp. RTS5128 Card Reader Con

Redirection Rules: 9

*

* ¥

Use redirection rules to manage specific USB devices.

Maximum number of rules: 10

Aow =] vendorio: [ productos [ ] Akt &

Citrix ICA Optio

Item

Description

Redirection Rules

Create redirection rules on 9 to manage specific USB devices with information on a

%J‘

NOTE

« All attached USB devices will be listed under Plugged USB Devices (0) with vender
and product information needed for creating rules.
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Advanced Quick Connection Settings for VMware View Sessions
To configure advanced Quick Connection settings for VMware View sessions, please do the following:

1. On Atrust Client Setup, click System > Quick Connection.

® Atrust Client Setup AN FERIRER

Atl'l.l St Applications User Interface Derices Network Syseem

General

Time Zone ¢ Extra Application Buttons 1=

- Password e Web Browser
-~ Firmware Update

- Appliance Mode * This setting will take effect after you re-enter the Quick Connection mode.
Al

o Setup .
Quick Connection ~ VMware View Option

- Terminal . -

" Error Report Mass Storage: [Enabled B

- Certfficate Manager Smart Cardk [Disabled -l 0
Human Interface Device: [Disabled B

Plugged USB Devices:
(vendor: 07ab Product: fcf6) Freecom Technologies DataBar 512 MB —
(vendor: 2047 Product: 03df) Texas Instruments

(vendor: 046d Product: c52e) Logitech, Inc. 9
(Wendor: 076b Product: a022) OmniKey AG CardMan Smart@Link

Redirection Rules:
¥ Use redirection rules to manage specific USB devices.
* Maximum number of rules: 10 e

vendor o [ productio: [ ]| aas

| Save H Cancel l

2. Click drop-down menus to configure Generic Settings (0) for mass storage devices, smart cards, and human
interface devices. Two options are available: Enabled or Disabled.

Mass Storage: |Enabled |
Smart Card: | Disabled ~| e
Human Interface Device: | Disabled ~] e

3. Use Redirection Rules (6) to manage specific USB devices:

Plugged USBE Devices: g
(Vendor: 046d Product: ¢52e) Logitech, Inc.

Redirection Rules: e
¥ Use redirection rufes fo manage specific USE devices.

® Maximum number of rules: 10

Vendor ID: | | Product ID: | Add

. Referto (9) to fill in the Vender and Product IDs for a specific device, click the drop-down menu to select
Allow or Deny.

« Click Add on the right to add a rule on (9).
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%J‘ NOTE

+ All attached USB devices will be listed under Plugged USB Devices (9) with vender
and product information needed for creating rules.

« Redirection Rules (e) have priority over Generic Settings (o).

4. Click Save to apply.

Accessing the Internet Locally in Quick Connection Mode

To access the Internet locally in Quick Connection mode, you can configure to show the Web Browser button on
Atrust Quick Connection screen:

~ Extra Application Buttons
I-l. Web Browser

* This setting will take effect after you re-enter the Quick Connection mode.

Atrust Quick Connection Screen

Atrust Quick Connection

=% Remote Desktop
" Citrix
B VMware View

*) Web Browser

" ®) Web Browser
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4.2.12 Managing the Use of Power

To manage the use of power for your mobile thin client, please do the following:

1. On Atrust Client Setup, click System > Power Management.

N IS
®) Atrust Client Setup o alliCS
Atrust Applications  User Interface Derices Network System.
- Time Zone
.- Password ¢ Power Management
- Firmware Update AC power saving mode: [
- Appliance Mode
- Quick Connection
Tarn off LCD: Never i
- Terminal Enter Suspend or Shutdown: E
- Error Report
- Certificate Manager Suspend or Shutdown after (Never = Disable) [
- Advanced
Battery power saving mode: e
Dimmed LCD: 5 minutes later E
Turn off LCD: 10 minutes later =
Enter Suspend or Shutdown: =
Suspend or Shutdown after (Never = Disable) 1 hour later =
Save ] | Cancel

2. Choose the desired power-saving mode for your AC power and battery, or choose Custom to customize
individual settings, and then click Save to apply.

? NOTE

+ When your mt168L enters System Sleep mode manually (Fn + F12 or @ >
Suspend) or automatically (configured in Atrust Client Setup through System >
Power Management), it still requires a certain amount of power. You can use
Shut down option instead to save the power to a greater degree.

@ WARNING

« When using only the battery as the power source, ensure that it has enough power
to prevent data loss.
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4.2.13 Enabling or Disabling the Command-line Functions

To enable/disable the execution of the text-based (command-line) functions, please do the following:

1. On Atrust Client Setup, click System > Terminal.

Atrust

Navigator

- Time Zone

- Password

- Firmware Update
- Appliance Mode
- Auto Setup

- Quick Connection

~Error Report
- Certificate Manager

2. Click to check/uncheck Enable to allow/disallow the execution of the command-line functions.

Save H Cancel |

Atrust Client Setup
Applications User Interface Derices Network System

General

- Basic Settings
‘ . | Enable

3. Click Save to confirm your change.

4. The shortcut appears/disappears on the Start menu for access.

%J‘ NOTE

. Atrust Client Setup
a Mixer
& Power Resurme Manager

W System Information
Bl Terminal

+ On the local Linux desktop, click START > Settings > Terminal to open the
Terminal window.
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4.2.14 Collecting Event Logs and Capturing Related Screens

The Error Report feature allows you to collect event logs and capture related screens for error reporting.

Collecting Event Logs
To collect event logs of your mt168L, please do the following:

1. Plug a USB flash drive into your mt168L.

=) NOTE
Z

« This USB flash drive will be used for storing the event logs of your mt168L.

- Ensure that you have enabled the access and automount of USB storage devices.
For detailed instructions, please refer to section “4.4.3 Configuring Settings for USB
Storage Devices” on page 89.

NOTE

allt]

- Please note that files saved on the local desktop will be deleted after restart.

2. On Atrust Client Setup, click System > Error Report.

® Atrust Client Setup AN FERIRER

Atl'l.lSt Applicati User Interf: Devices Network System

- Time Zone
- Password ¢ Collect Log
-~ Firmware Update Collect event logs to USB storage for troubleshooting.
- Appliance Mode

Auto Setup Please send the Error Report file to your administrator,
- Quick Connection
- Terminal

Certificate Manager
- Advanced

Collect Log

~ Launch Screenshot

Execute a screenshot tool to capture your screen.

Launch Screenshot

s Upload Files

FTP Server Address: o | =
FTF Username: | ‘ e
FTP Password: [ | =

Upload Check

Back
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3. Click Collect Log. A window appears prompting you to choose where to save the log file set (named
events.tar.gz). The attached USB flash drive is the default location if attached. Click Save to apply.

T T
- Save Archive file to X

Look in: [ImedlafBOOT :] € » & B[] E]
g Co... efi

user firmware
BOOT install.386

File name: | ETEERETE:: ]
Files of type: [Archive Files (*.tar.gz) = ]

Capturing Error-Related Screens
To capture error-related screens of your mt168L, please do the following:

1. On Atrust Client Setup, click System > Error Report.

2. Click Launch Snapshot to open the screen capturing program.

- Screenshot

Screenshot
Take a screenshot
Region to capture Delay before capturing

1 Entire screen seconds

) Select & region

[1 Capture the mouse pointer

3. Configure screen capturing settings directly on the opened window if needed, and then click OK to capture
the desired screen.

TIP
@
« It's recommended to set the delay time before capturing to at least 2 seconds to
reserve time for switching to the desired screen or window.

« It's recommended to save the captured screens in the same USB flash drive where
the event logs were saved.

« Please note that files saved on the local desktop will be deleted after restart.
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4.2.15 Uploading Files for Error Reporting

You can upload files to a specified FTP server for error reporting.
To upload files to an FTP server, please do the following:

1. On Atrust Client Setup, click System > Error Report.

. EEEE
®) Atrust Client Setup o alliCS
Atl'l.lSt Applicati User Interf: Devices Network System
- Time Zone
.- Password ¢ Collect Log
- Firmware Update Collect event logs to USB storage for troubleshooting.
- Appliance Mode
- Auto Setup Please send the Error Report file to your administrator.
-~ Quick Connection
- Terminal
I
- Certificate Manager Collect Log
~Advanced -
¢ Launch Screenshot
Execute a screenshot tool to capture your screen,
Launch Screenshot
- Upload Files
FTP Server Address: [ | =
FTP Username: [ =
FTP Password: [ | .__
Upload Check
Back

2. Under the Upload Files section, type the IP address of the FTP server and credentials, click Upload to select
and upload files to that FTP server.

- Select files for upload il

Look in: [Ihome}user 3] {*}El E-:'} 5 ] @
user Desktop

Documents

Music

Fictures

Public

Templates
Videos

File name: [ l 'E?gpen

Files of type: [Archlve Files (*.tar.gz) H l

+ You can check the validity of the IP address and credentials first through the
Check button.
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4.2.16 Importing Certificates for Remote Computers

You can import certificates for remote computers through:

« Alocal device (from a USB storage device)

«  The network (from a remote computer or the management console)

NOTE

+ The available management console for mt168L is Atrust Device Manager, a remote
and group management console for multiple thin clients. For more information,
please refer to the User’s Manual for Atrust Device Manager.

0

Importing certificates through a USB storage device

To import certificates for remote computers through a USB storage device, please do the following:
1. Copy your certificates to a USB storage device, and then connect this storage device to your mt168L.
2. On Atrust Client Setup, click System > Certificate Manager.
3. Click Add on the top of the Certificate list.

® Atrust Client Setup AN FERIRER
Atl'l.l St Applications User Interface Derices Network System
e R
Time Zone Issuedto % Issued by Expired on Valid Imported from

- Password

-~ Firmware Update

- Appliance Mode
Auto Setup

- Quick Connection

-~ Terminal

- Error Report
Certificate Manager
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4. In the From File section, click Browse to locate the desired certificate file, and then click Open to confirm.

Atrust

Navigator

- Time Zone

~ Password

- Firmware Update
-~ Appliance Mode
- Auto Setup

-~ Quick Connection
-~ Terminal

Certificate Manager

Atrust Client Setup AR
Applications User Interface Derices Network System
General
¢ From File

Specify the file you want to import {up to 16 certificates in total, including those from
servers).

File Mame: | Browse... Import

Note: Please select PEM or DER format certificate from your USB storage device,

~ From Server

Enter the IP address / URL / FQDN of the server where you want to get the certificate(s),
and then click Import (up to 16 certificates in total, including those from files).

IP address / URL/ FQDN: | || mpert
¢ From Atrust Device Manager
Click Import to get the certificate(s) from the Atrust Device Manager.
Import

Cancel

5. Click Import to start importing the certificate.

6. On completion, the certificate is shown in the Certificate list.

®) Atrust Client Setup Lo
Atl'l.l St Applications User Interface Derices Nemork System.
e )=
~Time Zone v
- Password Issued to Issued by Expired on

- Firmware Update
-~ Appliance Mode
- Auto Setup

-~ Quick Connection
-~ Terminal

rror Report

Certificate Manager

tarfield Root Certificate Authority - G2 Microsoft Code Verification Root 2021-04-15
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Importing certificates from remote computers through the network
To import the certificate from a remote computer through the network, please do the following:

1. On Atrust Client Setup, click System > Certificate Manager.
2. Click Add on the top of the Certificate list.

3. Inthe From Server section, type the IP address / URL / FQDN of the remote computer, and then click Import.

®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Devices Nemwork System
-~ Time Zone
- Password ¢ From File
~ Firmware Update Specify the file you want to import (up to 16 certificates in total, including those from
-~ Appliance Mode servers).
- Auto Setup
- Quick Connection File Name: I | Browse... Import
Terminal
~ Error Report Note: Please select PEM or DER format certificate from your USB storage device,
Certificate Manager
¢ From Server

Enter the IP address / URL / FQDN of the server where you want to get the certificate(s),
and then click Import (up to 16 certificates in tetal, including those from files).

IP address / URL / FQDN: |wwwgoog\e.com | Import

» From Atrust Device Manager

Click Import to get the certificate(s) from the Atrust Device Manager.

Import
Cancel
4. On completion, the certificate is shown in the Certificate list.
®) Atrust Client Setup o ol
Atru St lications User Interface Devices Nework System
App

;_:__;L”;iv;zoorge Issued to ¥ lssued by Expired on Valid Impo
- Firmware Update eoTrust Global CA Equifax Secure Certificate Authority 2018-08-21 Walid Serve
-~ Appliance Mode

- Auto Setup

~Quick Connection

- Terminal

- Error Report
Certificate Manager
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Importing certificates from Atrust Device Manager through the network
To import certificates from Atrust Device Manager through the network, please do the following:

NOTE

- Before proceeding, ensure that (1) your thin client has been added into a managed
group in the management console, that is, Atrust Device Manager, and that (2) you
have imported certificates into the management console.

% ‘

1. On Atrust Client Setup, click System > Certificate Manager.
2. Click Add on the top of the Certificate list.

3. Inthe From Atrust Device Manager section, click Import to start importing all certificates available in
Atrust Device Manager.

4. On completion, the certificates are shown in the Certificate list.

®) Atrust Client Setup o =llCS
Atru St Applications User Interface Devices Newwork System
S ) -
:_:_;L”;if;ge Issued to v Issued by Expire
Firmware Update | Go Daddy Secure Certificate Authority - G2 Go Daddy Foot Certificate Authority - G2 2031-
Starfield Root Certificate Autherity - G2 Microsoft Code Verification Root 2021-

- Appliance Mode
- AEFU Setup Starfield Secure Certificate Authority - G2 Starfield Root Certificate Authority - G2 2031-
- Quick Connection

Terminal

-~ Error Report
Certificate Manager
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4.2.17 Enabling or Disabling Auto Registration

Auto Registration allows that thin clients automatically register with Atrust Device Manager when they are online
and then become managed by Atrust Device Manager.

NOTE

- For this feature to work, Auto Registration must be enabled on both sides: thin
clients and target Atrust Device Manager. In addition, some configurations on
DHCP or DNS server over your network are required. For details, please refer to the
User’s Manual for Atrust Device Manager.

=

- By default, Auto Registration is enabled on thin client side, disabled Atrust
Device Manger.

To enable or disable Auto Registration on your thin client, please do the following:

1. On Atrust Client Setup, click System > Advanced.
2. Check/ Uncheck to Enable Auto Registration to enable / disable Auto Registration.

® Atrust Client Setup G Lkl
Atrust Applicati User Interf: Devices Network System

Time Zone

- Password - Auto Registration

-~ Firmware Update
- Appliance Mode
- Auto Setup
~Quick Connection S 1 —
- Terminal | Save ] | Cancel J
~ Error Report

- Certificate Manager

.. ¥ Enable Auto Registration

3. Click Save to apply.
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4.3 Configuring User Interface Settings

4.3.1 User Interface Tab Overview

User Interface tab enables you to configure settings for the user interface of clients. To access available settings of
User Interface tab, click the tab on Atrust Client Setup.

Atrust

o s ee Display

' Screensaver

User Interface Tab Overview

Atrust Client Setup

Applications User Interface Derices

sl

2 Configure display settings

Network

System

eceep o

" Desktop
~—— Configure desktop settings

) Keyboard
S Configure keyboard settings

", Mouse
Configure mouse settings

- Screensaver
= Configure screensaver settings

Interface Elements

No. Name

Description

1 Navigation area

Click to select a setting item under User Interface tab.

2 Configuration area

Configures setting values when a setting item or entry is selected.
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4.3.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
Display ﬁ_. Click to configure display settings. 4.3.3 77
o 4.3.4 80
Desktop (<4 Click to customize desktop and system language. 4.3.5 82
T 4.3.6 83
User Interface Keyboard :.L-;. Click to adjust keyboard settings. 4.3.7 84
Mouse - Click to adjust mouse settings. 4.3.8 86
Screensaver '!i: Click to configure screensaver settings. 4.3.9 87

4.3.3 Configuring Display Settings

To configure display settings for your mt168L, please do the following:

1. On Atrust Client Setup, click User Interface > Display.

® Atrust Client Setup | =W | NN [
Atrust Applications  User Interface Devices Network System
Navigator General
Displa
- Desktop ¢ Display
- Keyboard Mumber of Display: | 1 Ll [
- Mouse
- Screensaver Display Layout: [use Lco =l
¢ Monitor Settings
‘ Resolution: [Auto (1366x768) -le ‘
| Save H Cancel

2. Click drop-down menus to select the number of attached display(s), arrangement of displays, resolution, etc.
Refer to the following table to select appropriate setting values.
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(i)

« The available setting items vary, depending on your model and the selected
number of display(s).

Display

Item

Description

Number of Display

Click to select the number of used display(s).

Option Description
1 One display is used.
2 Two displays are used.

Display Layout

Click to select the arrangement of displays.

Option Description
Use LCD Use the single internal display (LCD panel).
Use VGA Use the single external display attached to the VGA port.

Use dual displays.
_ Two displays are arranged horizontally:
(LCD - VGA) the LCD one is on the left; the VGA the right.
The LCD one is the main display for local desktop when
Extend is selected.

horizontal

Use dual displays.
) Two displays are arranged horizontally:
(VGA - LCD) the VGA one is on the left; the LCD the right.
The VGA one is the main display for local desktop when
Extend is selected.

horizontal

Display Mode

This item is available only when 2 is selected in the Number of Display drop-
down menu:

Option Description

Extend One display is used as the extended display of the other.

Clone Two displays have the same display content.
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Monitor Settings

Item

Description

Enable Auto-Detection at
Power-up

Check/Uncheck to enable/disable the automatic detection of the used monitor(s)
when the client is powered on.

Option Description

Automatic detection of the used monitor(s) is enabled.
Enabled The system would set an appropriate resolution for the
used monitor(s) when the client is powered on.

Automatic detection of the used monitor(s) is disabled.
All resolutions supported by the client will be listed in the

Disabled Resolution drop-down menu when Auto-Detection at
Power-up is disabled. Please note that some resolutions
may not be applicable to your monitor(s).

Monitor Resolution

Use this item to set an appropriate resolution for the used display.

Option Description
A This option is available only when Enable Auto-Detection
uto -
at Power-up is selected.
Other Select the desired resolution from the Resolution drop-down
options menu for the used display.

NOTE: All resolutions supported by the client will be listed in the Resolution
drop-down menu when Auto-Detection at Power-up is disabled.
Please note that some resolutions may not be applicable to
your monitor(s).
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4.3.4 Customizing Desktop and System Language Settings

To customize desktop and system language settings for your mt168L, please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

®) Atrust Client Setup o alliCS
Atrust Applications  User Interface Devices Network System
Navigator General
- Displa
Desktop r System Language )
- Keyboard Language: [English -1&
- Mouse

- Screensaver This setting will take effect after reboot,

- Desktop Fonts
Default Font: [sans -

=
Default Font Style: |Regu\ar hd Il
Default Font Size: [12 hd 'S
Title Font: [sans N
Title Font Style: |Regu\ar hd Il
Title Font Size: [1z -

- Desktop lcons
Remote Desktop

Citrix
VMware View

[ =

+| Firefox Web Browser
Libreoffice

PDF Viewer (Document Viewer)

e

Save ] | Cancel

2. Click drop-down menus or tick/untick checkboxes to choose desired settings. Refer to the following table for
a description of each setting item.

System Language

Item Description

Click the drop-down menu to select the system language.

Language NOTE: Available languages may vary with the firmware version of your device.
NOTE: You need to restart the system for the change to take effect.

Desktop Fonts

Item Description

Default Font Click the drop-down menus to select the desired font, its style and size used for
the user interface of the operating system, such as menus, options on menus,

Default Font Style text labels for desktop shortcuts, tabs on program windows etc.

NOTE: Your changes will not apply to the titles of opened windows, the Atrust
Client Setup console, and the System Information window (START >

Default Font Size System Settings > System Information).
Title Font
Title Font Style Click the drop-down menus to select the desired font, its style and size used for

the titles of the opened windows.

Title Font Size
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Desktop Icons

Item

Description

Remote Desktop

-

Check/Uncheck to show/hide shortcuts Remote Desktop [ on the START

menu and local Linux desktop for service quick access.

For more information, please refer to section “4.3.5 Hiding or Showing Quick
Access Shortcuts” on page 82.

Citrix

Check/Uncheck to show/hide shortcuts Citrix on the START menu and local

Linux desktop for service quick access.

For more information, please refer to section “4.3.5 Hiding or Showing Quick
Access Shortcuts” on page 82.

VMware View

oda

Check/Uncheck to show/hide desktop shortcuts VMware View on the

START menu and local Linux desktop for service quick access.

For more information, please refer to section “4.3.5 Hiding or Showing Quick
Access Shortcuts” on page 82.

Icon Size

Click the drop-down menu to select the desired size of desktop icons/shortcuts.

Icon Font Size

Click the drop-down menu to select the desired text label size of desktop
icons/shortcuts.

Desktop Background

Item

Description

Enable Desktop Wallpaper

Check/Uncheck to enable/disable the use of Atrust wallpaper.

NOTE: If disabled, the solid color background (dark blue) will be used.

Enable Custom Wallpaper

Download From

Custom Wallpaper File

Check/Uncheck to enable/disable the use of a custom wallpaper. More settings
appear when checked.

For details, please refer to "4.3.6 Using a Custom Wallpaper” on page 83.

Wallpaper Style

Click the drop-down menu to select the way to apply the wallpaper. Five options
are available: Centered, Tiled, Stretched, Scaled, and Zoomed.

Option Description

Centered Centers the original image on the screen.

Tiled Tiles the screen with the original image.

Stretched Centers and extends/shrinks the image to fit the screen.
Scaled Centers and sizes the image proportionally to fit the screen

until the top-bottom or left-right sides fit the screen.

Zoomed Centers and sizes the image proportionally to fill the screen.

NOTE: Depending on the size of the connected display, two options might have
the same effect.

Wallpaper

Click the drop-down menu to select the color of Atrust wallpaper. Four colors are
available: Green, Blue, Orange, and Cyan.

3. Click Save to apply.
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4.3.5 Hiding or Showing Quick Access Shortcuts

In case you want to access services quickly right on the local desktop, you can choose to show Quick Access
shortcuts Remote Desktop / Citrix / VMware View on the START menu and local Linux desktop. These shortcuts
enable you to access services quickly by clicking.

NOTE
+ They're hidden by default.

ol

To show/hide shortcuts Remote Desktop / Citrix / VMware View on the START menu and local Linux desktop,
please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Dervices Nework Sysem
Navigator General
Displa .
Desktop ¢ System Language -
- Keyboard Language: [English 1o
- Mouse
- Screensaver This setting will take effect after reboot,

- Desktop Fonts

Default Font: [sans hd Il
Default Font Style: |Regu\ar hd 'S
Default Font Size: [12 hd Il
Title Font: [sans hd Il
Title Font Style: [Regular N
Title Font Size: [12 -l e |

- Desktop lcons
Remote Desktop

Citrix

[

VMware View

Libreoffice
PDF Viewer (Document Viewer) hd|

[
-
(SR Firefox Web Browser
-

Save H Cancel |

2. Click to check/uncheck Remote Desktop / Citrix / VMware View in the Desktop Icons section to show/hide
the quick access shortcuts Remote Desktop / Citrix / VMware View on the START menu and
local Linux desktop.

3. Click Save to apply the change.
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4. The selected shortcuts will be shown/hidden.

| 7« Remote Desktop
@ Citrix
= VMware View

ol Accessories
| Settings

© Log Out
1y
SnART i 0 <G 14:48

Atrust

4.3.6 Using a Custom Wallpaper
To use a custom wallpaper, please do the following:
1. On Atrust Client Setup, click User Interface > Desktop.

®) Atrust Client Setup

Al:l'usl: Applications User Interface Derices Nemwork System

General

¢ Deskiop Icons
e Remote Desktop

- Keyboard
- Mouse
-~ Screensaver

Citrix

&
[ WVMware View

._'__ + Firefox Web Browser
e Libreoffice

. || PDF Viewer [Document Viewer)

lcon Size: [32

Icon Font Size: [10

- Desktop Background
g +| Enable Desktop Wallpaper

.;_ Enable Custom Wallpaper

Wallpaper Style: | Stretched
wallpaper: [Blue
| Save ] | Cancel ]

2. Check or Uncheck Enable Custom Wallpaper to enable or disable the use of a custom wallpaper.
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3. Select the way to apply the wallpaper and where to download or get the image file. Three options are
available to get the wallpaper: Auto Setup, Atrust Device Manager, and File.

NOTE

il

- If Auto Setup is selected, your thin client must be in Auto Setup environment and
be well-configured for that environment. Please see “4.2.9 Enabling or Disabling
Auto Setup” on page 60 for more information.

- If Atrust Device Manager is selected, your thin client must be managed by Atrust
Device Manager. For details, please see the User’s Manual for Atrust Device Manager.

4. Provide other information if required.

NOTE

il

- IfFile is selected, you need to specify where to get the image file locally, for
example, a locally attached USB flash drive.

+ The maximum allowed size of a custom wallpaper file is 5 MB.

5. Click Save to confirm.

4.3.7 Adjusting Keyboard Settings

To adjust keyboard settings for your mt168L, please do the following:

1. On Atrust Client Setup, click User Interface > Keyboard.

- P
® Atrust Client Setup o Lol
Atl'l.l St Applications User Interface Dervices Network System
General
- Keyboard
= Use Custom Keyboard Settings
Screensaver keyboard Layout: |Japanese {is) ‘ e
Keyboard Type: |Japanese 106-key ‘ =
NumLock
NumLock Mode: [Single Numeric Key -] =
E Enable NumLock on Boot
Cursor
L. ¥ Show Blinking
Blink Delay 1300 E
Type Settings
Repeat Speed [20 | e
— ] ]
Repeat Delay \SUU | =
Save ] | Cancel

2. Click drop-down menus, tick/untick checkboxes, or move sliders to choose desired settings. Refer to the
following table for a description of each setting item.
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Keyboard

Item

Description

Use Custom Keyboard Settings

Check/Uncheck to enable/disable the use of custom keyboard settings.

NOTE: You are allowed to set the keyboard layout and type only when this
setting is enabled.

Keyboard Layout

Click the drop-down menu to select the desired keyboard layout.

Keyboard Type

Click the drop-down menu to select the desired keyboard type.

Single Numeric Key
NumLock

In NumLock mode, single numeric key is sufficient to enter a number.

Mode .
Fn + Numeric Key

In NumLock mode, Fn plus numeric key is required to enter a number.

Enable NumLock on Boot

Check/Uncheck to enable/disable the NumLock key after system startup.

Show Blinking Check/Uncheck to enable/disable the cursor blinking (local desktop only).
Cursor
Blink Delay Move the slider to select the blink delay between each occurrence of cursor.
T Repeat Speed Move the slider to select the character repeat rate when a key is held down.
ype
Settings

Repeat Delay

Move the slider to select the character repeat delay between its each occurrence.

s TIP
+ Hang your mouse over the Up/Down arrow to quickly scroll up/down the Keyboard
Layout list.
Up arrow
Arabic

Arabic (AZERTY)

Arabic (AZERTY /[ digits)
Arabic (digits)

Arabic (QWERTY)
Arabic fwimmm

Canada (French Dvorak)

Canada (French (legacy)}

Canada (Multilingual)

Canada (Multilingual first part)
Canada (Multilingual second part)

-

Down arrow —I

- To fine-tune a setting value, click its slider, and then use the Right/Left key to
increase/decrease the value by 1 or the Page Up/Page Down key to increase/
decrease by 10.

3. Click Save to apply.
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4.3.8 Adjusting Mouse Settings

To adjust mouse settings for your mt168L, please do the following:

1. On Atrust Client Setup, click User Interface > Mouse.

Atrust

- Display
- Desktop
-~ Keyboard

- Screensaver

Atrust Client Setup

Applications User Interface Derices Network System

¢ Mouse
Button Order: [Right handed
Enable touchpad: [ves
Feedback

Acceleration [2 |

Threshold [17 |

Save H Cancel ]

2. Click the drop-down menu or move sliders to choose desired setting values. Refer to the following table for a
description of each setting item.

Mouse

Item

Description

Button Order

Click the drop-down menu to switch mouse buttons for right-hand/left-hand use.

Enable Touchpad

Click the drop-down menu to enable or disable the touchpad.

Feedback

Acceleration

Move the slider to select the rate at which the mouse increases speed while moving.

Threshold

Move the slider to select the moved distance (pixels) after which the mouse starts
to accelerate.
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4.3.9 Configuring Screensaver Settings

To configure screensaver settings for your mt168L, please do the following:

1. On Atrust Client Setup, click User Interface > Screensaver.

®) Atrust Client Setup o alliCS
Atrust Applications  User Interface Devices Network System
- Display
- Desktop r Screensaver
- Keyboard E Enable Screensaver
- Mouse
Display Mode: E
Display After (minute): E
E Enable Display Sleep Mode
Enter Display Sleep Mode after Screensaver (minute): =
e On Resume, Password Protect
When | close the lid: Turn off LCD hd il

Save ] | Cancel

2. Click drop-down menus or tick/untick checkboxes to choose desired settings.

Screensaver

Item

Description

Enable Screensaver

Check/Uncheck to enable/disable Screensaver.

Display Mode

Click to select the display mode of the screensaver. Two options are available:
Blank and Logo.

Option Description
Blank Displays a black screen.
Logo Displays the Atrust floating logo.

Display After (minute)

Click to select the wait time for screensaver.

Enable Display Sleep Mode

Check to turn off (i.e. stop sending signals to) the display to maximize the
energy savings.

Enter Display Sleep Mode after
Screensaver (minute)

Click to select when to turn off (i.e. stop sending signals to) the display after
Screensaver starts.

On Resume, Password Protect

Check/Uncheck to resume with/without a password.

When I close the lid

Click to select what to do when closing the lid.

TIP

@

- While setti

ng wait time for screensaver, you can hang your mouse over the Up/

Down arrow to quickly scroll up/down the Minute list.

3. Click Save to apply.
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4.4 Configuring External Device Settings

4.4.1 Devices Tab Overview

Devices tab enables you to configure settings for external devices of clients. To access available settings of Devices
tab, click the tab on Atrust Client Setup.

Devices Tab Overview
i lodl JdlEdlsad
® Atrust Client Setup E | =N (=0 [
Atl'l.lSt Applications User Interface Devices Network System
a............éousa Storage
~Audio USE Storage e

- Printer

Configure USE storage settings

Q| At

Configure audio device settings

. Printer
== srdd local and network printers

Interface Elements

No. Name

Description

1 Navigation area

Click to select a setting item under Devices tab or to select a setting
entry under a selected setting item.

2 Configuration area

Configures setting values when a setting item or entry is selected.




4.4.2 Available Settings at a Glance

Tab Setting Icon

USB Storage 'LP
Devices Audio QI“

Printer A

Configuring Client Settings |89

Configuring External Device Settings

Description

Click to configure settings for USB storage devices.

Click to configure settings for audio devices.

Click to add local or network printers.

4.4.3 Configuring Settings for USB Storage Devices

To configure settings for USB storage devices, please do the following:

%J NOTE

«+ To access locally attached USB storage devices in a local or virtual session, you need

to configure appropriate settings under this setting item.

1. On Atrust Client Setup, click Devices > USB Storage.

Atrust Client Setup v ool
Atl'l.l St Applications User Interface Devices Network System
Navigator General
LSB Storage
- Audio r USB Storage
- Printer v Enable USB Storage

L. ¥ Enable Automount

¥ This setting will take effect after reboot.

Save H Cancel |

2. Tick/untick the checkboxes to choose the desired settings.

Section

4.4.7
4.4.8

Page

89
90

91
92

93
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Settings for USB Storage Devices

Item Description

Tick/Untick this checkbox to allow/disallow the access of USB storage devices.

NOTE: To use the locally attached USB storage devices in an RDP / ICA / View
session, the mapping of local USB storage devices must be enabled

in this session’s RDP / ICA / View connection settings. For detailed
Enable USB Storage instructions and more related settings, please refer to sections:

"4.6.5 Configuring Advanced RDP Connection Settings” on page 137
"4.6.11 Configuring Advanced ICA Connection Settings” on page 175
“4.6.14 Configuring Advanced View Connection Settings” on page 208

Tick/Untick this checkbox to enable/disable the automount of
USB storage devices.

NOTE: If this setting is disabled, users need to manually mount the attached
Enable Automount USB storage devices. For detailed instructions, please refer to section

“4.4.4 Manually Mount and Eject Attached USB Storage Devices” on page
90.

3. Click Save to save your change.

—=)») NOTE
7
- For your changes to take effect, you need to restart your system.

4.4.4 Manually Mount and Eject Attached USB Storage Devices

To mount/eject an attached USB storage device, please do the following:

NOTE

i

- If Enable Automount is checked (see section “4.4.3 Configuring Settings for USB

Storage Devices” on page 89), then an attached USB storage device will be
mounted automatically.

1. Right click the desktop icon of the attached USB storage device.

2. A popup menu appears.

& Open

Mount Velume

& Eject Volume

3. Click to select Mount Volume/Eject Volume to mount\eject the attached USB storage device.
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4.4.5 Disabling or Enabling Attached Audio Devices

To disable/enable attached audio devices, please do the following:

=

NOTE

If you disable locally attached audio devices, client users are not allowed to perform
audio playback or recording with these devices in an RDP / ICA / View session.

To perform audio playback or recording with local audio devices in an RDP / ICA /
View session, you need to enable locally attached audio devices here

(the Audio setting item under Devices tab) and configure audio related settings
in the RDP /ICA / View connection settings. For detailed instructions, please

refer to sections:

< “4.6.5 Configuring Advanced RDP Connection Settings” on page 137
< “4.6.11 Configuring Advanced ICA Connection Settings” on page 175
< "4.6.14 Configuring Advanced View Connection Settings” on page 208

1. On Atrust Client Setup, click Devices > Audio.

®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Devices Nework Sysem
Navigator General

Audio
- Printer

- USB Storage

-~ Audio
.. ¥ Enable System Audio Device

* This setting will take effect after reboot.

| Save H Cancel |

2. Click to check/uncheck Enable System Audio Device.

3. Click Save to confirm your selection.

)

NOTE

- The change will not take effect until mt168L has been restarted.
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4.4.6 Using USB Audio Devices

By default, your mobile thin client would use built-in speakers and/or audio devices attached to 3.5 mm audio ports.
In case that you want to use a USB audio device, you need to change the default.

To configure default audio devices, please do the following:

1. Connect the desired USB audio device to your thin client.

2. On Quick Connection screen or local desktop, click ) icon in the bottom-right corner to open
the Mixer window.

4 Mixer | =R AR X
Playback Device: [HDA Intel PCH H ]
Capture Device: [HDA Intel PCH s ]
Playback Capture
Headphone Speaker Capture

il
& |ﬂ|

|

Save

Close

3. On the opened window, click the drop-down menu to select the USB PnP device.

'fi""____________________________WI'Iﬂllﬂ'iﬂ‘!r

i
£

|

Mixer

ﬂ

A1 ESNIEN R

|

Z

NOTE

'fi"""""""""""""""""'1I'Imllﬂl'ﬂl'!r

1
|

Mixer

0| RSN IER R

Playback Device: HDA Intel PCH Playback Device: [EUSB PnP Sound Devic % ]
) USE PnP Sound Device ] -
Capture Device: [ e ] Capture Device: [HDA Intel PCH ¥ ]
Playback Capture Playback Capture
Headphone Speaker Capture Capture

I

« The default for Playback and Capture devices is HDA Intel PCH. Available options
may vary with your thin client model.

4. Click Save to confirm.




4.4.7 Adding aLocal Printer

To add a local printer for your mt168L, please do the following:

1.

Connect the desired printer to your mt168L and turn on the printer.

2. On Atrust Client Setup, click Devices > Printer.

o v ok W

®) Atrust Client Setup

Atl'l.l St Applications User Interface Devices

|+ add || = Delete |

- USB Storage
’““AUdiU
Printer

Printer Name ¥ Printer URI

Click Add on the top of the Printer list.

The system automatically start searching for available local printers.
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0 | W NN

Syseem

Upon completion, the discovered local printers will be listed on the Printer Port drop-down menu.

Click the Printer Port drop-down menu to select the desired local printer.

TCP Metwaork Printer
LPD Network Printer
IPP Metwork Printer
EPSON EPL-6200L

Fields in the Add Printer section will automatically change to fit the type of the selected printer.
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8. Afield for the selected printer appears and the printer URI (Uniform Resource Identifier) data is automatically
filled out in the field.

- laEEE
® Atrust Client Setup | =W | NN [
Atl'l.l St Applications User Interface Devices Network System
General
- USB Storage
- audio ~ Add Printer
Printer Name * | \ [
[Prmter Fort: EPSON EPL-6200L 'I [
EPSON EPL-6200L * [?serial=23P160612111836080 B
Description: | ‘ e
Manufacturer: |Generic hd il ™
Printer Model: | hd [ T
e Share Printer
. ¥ Mapping in RDP Sessions
L. ¥ Mapping in ICA Sessions
L. ¥ Mapping in VMware Sessions
Windows Driver Name [ | =
RDP Printer Mapping Name [ =
Save l | Cancel

NOTE

]

« A URI (Uniform Resource Identifier) is a sequence of characters that is used to
identify a resource on the Internet.

9. Click the Manufacturer and Printer Model drop-down menus to select the manufacturer and model for the
attached local printer.

—)) NOTE
i
« For the printer to operate normally, you need to specify the correct information in
these two fields. Otherwise, the printer would fail to work.

10. Refer to the following table to configure desired settings.

—)) NOTE
i
+ You may need to provide the Windows driver name for your printer. For details,
please refer to descriptions in the table.

11. Type the desired printer name, and then click Save to apply.
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Settings for Printers

Item

Description

Share Printer

Check/Uncheck to share the printer.

Once Share Printer is checked, other computers in the same network segment
will be allowed to use the printer.

To add this shared printer for use on other computers, please do the following:

1. For computers running a Windows Server operating system, such as
Windows Server 2008 R2, please add the Internet Printing Client
feature first (Click Start > All Programs > Administrative Tools >
Server Manager > Action > Add Features > Internet Printing Client,
follow the wizard to complete the task, and then restart your system).

2. Click Start > Devices and Printers > Add a printer >
Add a network, wireless or Bluetooth printer.

3. Click Stop to cancel the automatic printer search, and then click
The printer that I want isn’t listed.

4. Under Select a shared printer by name, enter
http://IP address of your thin client:631/printers/Printer Name.

NOTE: For example, if a printer is locally attached to your thin client and is
added as a local printer through Atrust Client Setup with the printer
name EPS, and the IP address of your thin client is 192.168.50.146.
Here you should enter: http://192.168.50.146:631/printers/EPS

5. Click Next to continue.

6. Select the manufacturer and model of the printer, and then click OK to
install the correct driver.

7. Upon completion, a success message appears. Click Next to continue.
8. On the appeared page, click Print a test page to test the printer.
9. Click Finish to apply. The printer is added to the Printers and Faxes list.

Mapping in RDP Sessions

Check/Uncheck to enable/disable the locally connected printer in an RDP session.

Mapping in ICA Sessions

Check/Uncheck to enable/disable the locally connected printer in an ICA session.

Mapping in VMware Sessions

Check/Uncheck to enable/disable the locally connected printer in a View session.

Windows Driver Name

Keep this field blank, if the printer works well in a session. In case that the
printer fails to work, filling in this field may solve the problem.

To find out the required information, please do the following:

1. Attach the printer to a computer running a Windows OS, complete the
required installation, and ensure the printer works well.

2. Click Start > Devices and Printers, and then, in the opened window,
right click the printer to open a popup menu.

3. On the popup menu, click to select Printer properties.
4. In the opened window, click Advanced. The driver name is shown.

/=1 Epson EPL-6200L Properties ===

General | Sharng | Pots | Advanced | Color Management | Securty | Optional Settngs |

@ Always available

© Available from 00:00 : 00:00

Priority: 1

)
Driver: Epson EPL-6200L = || | New Driver
J

RDP Printer Mapping Name
(for RDP sessions only)

Type in the desired printer name in a session (Windows desktop). If this field
remains blank, the name you typed in the Printer Name field will be used.
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4.4.8 Adding a Network Printer

To add a network printer for your mt168L, please do the following:

1. Ensure that your mt168L is connected to the network and the desired network printer is turned on.

. On Atrust Client Setup, click Devices > Printer.

2
3. Click Add on the top of the Printer list.
4

. The system automatically starts searching for available local printers. Upon completion, the discovered local
printers will be listed on the Printer Port drop-down menu.

5. Click the Printer Port drop-down menu to select the desired network printer. Three types of network printers
are available: TCP Network Printer, LPD Network Printer, and IPP Network Printer.

TCP Network Printer
LPD Metwork Printer
IPP Network Printer

6. Fields in the Add Printer section will automatically change to fit the type of the selected printer.

7. Typein the IP address of the network printer in the TCP Printer Server, LPD Printer Server, or IPP URI field.

~ Add Printer
Printer Name

Printer Port:
TCP Print Server
TCP Port

Description:

“ | | &
[ TCP Network Printer e
“ | | &
[9100 | &
| | &

- Add Printer

Printer Name
Printer Port:
LPD Print Server

LPD Queue Name

Description:

“ | |
[LPD Network Printer e

- Add Printer
Printer Name

Printer Port:
IPP URI

Description:

| ||.

[1PP Network Printer e

| ||..

| | &

8. Click the Manufacturer and Printer Model drop-down menus to select the manufacturer and model for the

desired network printer.

9. Refer to the table on page 95 to configure other printer settings, and then click Save to apply.
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4.5 Configuring Network Settings

4.5.1

Network tab enables you to configure network settings for clients. To access available settings of Network tab, click
the tab on Atrust Client Setup.

Network Tab Overview

® N PN R Y

Atrust

Navigator

Hosts

Host Name
o Wireless
:‘“"PFOX}‘

Network Tab Overview

Atrust Client Setup A | RN FE R

Applications User Interface Derices Network System
% | Ethernet cee

Configure wired network settings

ey VPN
e Configure VPN (\irtual Private Network) connection settings

i Hosts
E Create the mapping of IP addresses to host names and aliases

Host Name
Adjust the host name for your client

1

) Wireless

Configure wireless network settings

-\f.";j Proxy
=" Configure proxy settings for Web-based access to services

Interface Elements

No. Name Description
N Click to select a setting item under Network tab or to select a setting
1 Navigation area A
entry under a selected setting item.
2 Configuration area Configures setting values when a setting item or entry is selected.
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4,5.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
Ethernet L Click to configure wired network settings. 4.5.3 99
VPN oy Click to configure VPN (Virtual Private Network) 4.5.4 102
M‘ connection settings and create a VPN connection. 4.5.5 106
Click to create the mapping of IP addresses to 45.6 107
Hosts =i names or aliases of hosts and create the Failover 4'5'7 109
- Cluster list. =
Network
Host Name l; Click to change the host name of your thin client. 4.5.8 111
Wireless ® Click to configure wireless network settings and 44'55'191 ﬂi
‘ create a wireless connection. 4.512 117
5 Click to configure proxy settings for Web-based
Proxy § 9 4.5.13 118

i access to services.
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4.,5.3 Configuring Wired Network Settings
The Ethernet setting enables you to configure the wired network settings for your mt168L thin client.

Enabling or Disabling the Ethernet Network Interface
To enable/disable the Ethernet network interface, please to the following:

1. On Atrust Client Setup, click Network > Ethernet.

2. Under Interface section, check/uncheck Enable to enable/disable the Ethernet network interface.

- Interface
a v Enable

- |IP Address
IP Type:

[ DHCP M

- DNS
DNS Type:

[Dynamic DNS {via DHCP)  ~] |

3. Click Save to apply.

Using a Dynamic IP Address
To use a dynamic IP address, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the IP address section, click the drop-down menu to select DHCP for the IP type field.

NOTE

i

- If DHCP is selected, the DHCP server over the network will automatically assign
an IP address to your mt168L thin client. This is the default setting.

3. Click Save to apply.

Using a Static IP Address

To use a static IP address, please do the following:

%‘/ NOTE

+ It's recommended to use a dynamic IP address for your mt168L thin clientin a
corporate network environment.

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the IP address section, click the drop-down menu to select Static IP for the IP type field.

3. The IP address, Subnet mask, and Gateway fields appear in the IP address section.
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®) Afrust Client Setup
Atrust Applications User Interface Derices Newwork System
Navigator General
Ethernet
- Hosts ¢ IP Address
~ Host Name P Type: [static IP
- Wireless
- Proxy IP Address: [
subnet Mask: * |
Gateway: ¥ |

- DNS
Search Domain:

Mameserver 2:

|
Nameserver 1: * |
|

Save ] | Cancel

4. Typein the IP address, subnet mask, and gateway for your mt168L thin client.

« IP address
IP type: [ Static IP -]
IP address: + [192.168.12.88 |
Subnet mask: = [255.255.255.0 |
Gateway: = [192.168.12.254 | &

5/ NOTE

- Consult your network administrator for a free IP address and other required data
about the network to which your mt168L connects.

+ The red asterisks indicate the required fields.

5. Click Save to apply.

% NOTE

+ You need to further specify DNS server addresses manually if you choose to use a
static IP address.

Obtaining DNS Server Addresses Automatically
To obtain DNS Server addresses automatically, please do the following:

5/ NOTE

-+ You cannot obtain DNS server addresses automatically through the DHCP server if
you choose not to get the IP address via the DHCP server.
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1. On Atrust Client Setup, click Network > Ethernet.
2. Under the DNS section, click the drop-down menu to select Dynamic DNS (via DHCP) for the DNS type field.
3. Click Save to apply.

Specifying DNS Server Addresses Manually
To specify DNS Server addresses manually, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.
2. Under the DNS section, click the drop-down menu to select Manual setting.

3. The Search domain, Nameserver 1, and Nameserver 2 fields appear in the DNS section.

NOTE

]

« If you choose to use a static IP address for your mt168L thin client, then you need
to specify DNS server addresses manually. In this case, the DNS type field will not
appear for you to select Manual setting or Dynamic DNS (via DHCP).

® AtrUst Client Setup illa Ll
Atru St Applications User Interface Devices Network System
Navigator General
Ethernet
-Hosts ¢ IP Address
Host Name IP Type: DHCP -
~Wireless ‘ w | =
= Pro )
o - DNS
DNS Type: [Manual setting 1
Search Domain: | ‘ [
Nameserver 1: * | ‘ [
Nameserver 2: [ | &

Save ] | Cancel

4. Type in the preferred DNS server address in the Nameserver 1 field and the alternate DNS server address in
the Nameserver 2 field if any.

% -) NOTE
— . Specifying a domain name in the Search Domain field will enable your system to

discover a computer in that domain simply with its computer name rather than its
FQDN (Fully Qualified Domain Name).

5. Click Save to apply.
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4.5.4 Establishing and Stopping a VPN connection

The VPN setting enables you to establish/stop a virtual private network connection for your t180L/t180LB.

NOTE

« The VPN setting also allows you to configure and manage virtual private network
settings. For instructions on how to configure and manage virtual private network
settings, please refer to section “4.5.5 Configuring Virtual Private Network Settings”
on page 106.

=

Adding a Virtual Private Network
To add a virtual private network, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

® Atrust Client Setup | =W | NN [
Atl'l.lSt Applications User Interface Devices Network System
Navigator Connections Seftings
- Ethernet
VPN + Add — Delete
- Hosts
- Host Name Connection Name VPN Type  Status Comment

- Wireless
- Proxy

NOTE

- If you haven't created any entry, the Virtual Private Network list will be empty.

]

2. Click Add on the top of the Virtual Private Network list.
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3. On General tab, click the drop-down menu to select the desired VPN type. Three types are available: PPTP,

L2TP, and Cisco AnyConnect.

Atrust

Navigator

- Ethernet
VPN

- Hosts

- Host Name

Wireless

- Proxy

- Connection Settings

Atrust Client Setup

Applications User Interface Devices

General Options

A FENI R B

System

Connection Name: * |

VPN type: [peTP

Server Address: *

- Login Settings

Username: * |

Password: <

Domain: [

- Security and Compression Setting

= Use Point-to-Point encryption (MPPE)

- Authentication Settings

= Enable PAP

e Enable CHAP

.. ¥ Enable MSCHAP
+ Fnahle MSCHAPw?

Save H Cancel

=)) NOTE
=

+ The setting items will vary with the selected VPN type.

4. Type in or click drop-down menus to provide information about configuration and authentication.

%‘/ NOTE

« Consult your network administrator for required information on configuration and
authentication.

5. On Options tab, configure the DNS-related settings if needed.

6. Click Save to add the virtual private network.

Establishing a Virtual Private Network Connection
To establish a virtual private network connection for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.
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®) Atrust Client Setup cilo LEL L
Atl'l.lSt Applications User Interface Devices Network System
Navigator Connections Settings

- Ethernet
VPN + Add = Delete
-~ Hosts
i rv?:(:l'eusasme Connection Name VPN Type  Status Comment
- Proxy : ATSVPN PPTP Connected before

=)) NOTE
- If you haven't created any entry, the Virtual Private Network list will be empty. For
instructions on adding a virtual private network, please see the preceding topic.

2. Click to check the desired virtual private network. The Connect 4 Connect pytton then appears on the top
of the Virtual Private Network list.

® Atrust Client Setup silo LEL L
l\tl'l.ISt Applications User Interface Devices Network System
Navigator Connections Settings

- Ethernet
VPN + Add — Delete ~ Edit & Connect
- Hosts
:*V?rsetlzlssme Connection Name VPN Type  Status Comment
~ Proxy o o ATSVPN PPTP Connected before

3. Click Connect to create a virtual private network connection through the selected network entry.
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4. Upon completion, the Status column of the virtual private network will show connected.

® Atrust Client Setup | =W | NN [

Atl'l.lSt Applications User Interface Devices Network System
Navigator Connections Seftings

- Ethernet

VPN + Add — Delete
-~ Hosts
rv?rs;;":sme Connection Name VPN Type  Status Comment
ATSVPN PPTP connected Connected before, auto connect

- Proxy

Stopping a Virtual Private Network Connection
To stop a virtual private network connection, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network. The Disconnect /# Discennect pytton appears on the top of
the Virtual Private Network list.

3. Click Disconnect to stop the virtual private network connection.

Deleting a Virtual Private Network

To delete a virtual private network, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.
2. Click to check the desired virtual private network.

3. Click Delete to remove the selected virtual private network.
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4.,5.5 Configuring Virtual Private Network Settings

Adjusting Connection settings for a Virtual Private Network
To adjust connection settings for a virtual private network, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network. The Edit .~ Edit  button appears on the top of the
Virtual Private Network list.

3. Click Edit to adjust the settings, and then click Save to apply.

Configuring General Settings for Virtual Private Network Connections
To configure general settings for virtual private network connections, please do the following:

1. On Atrust Client Setup, click Network > VPN, and then click Settings sub-tab.

® Atrust Client Setup | =R | FEN (S

Atrust Applications User Interface Devices Network System

Connections Settings

¢ Connection
= Auto connect when startup

Automatic VPN Connection: ATSVEN

Save Cancel

2. Under the Connection section, click to check/uncheck Auto connect when startup to allow/disallow
automatic virtual private network connection after system startup. When this feature is enabled, select the
desired virtual private network through the drop-down menu.
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4,5.6 Creatingthe Mapping of IP Addresses to Names of Hosts

Atrust Client Setup allows you to use the name or alias of a host instead of its IP address wherever you need to
specify an IP address while configuring client settings. To use this feature, first you need to create the mapping of IP
addresses to names or aliases of hosts.

Creating the Mapping List
To create the mapping of IP addresses to names or aliases, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

®) Atrust Client Setup o+

Atru St Applications User Interface Devices Network System

Navigator | + Add H = Delete |

- Ethernet
Hosts
Host Name

~Wireless

- Proxy

Hostname ¥ IP Address Alias / Group Priority

2. Click Add to start adding a new host entry.
3. Typein the name, IP address, alias of a host, leave the Priority field blank, and then click Save to apply.

~ Hosts Table Settings

Hostname: * |WS2012R2RDSH | k&
IP Address: * [192.168.7.12 | &
Alias / Group: |ws12 | &
Priority. | | B

NOTE

=

- If your host belongs to a domain, please don't enter the FQDN (Fully Qualified
Domain Name) or full computer name in the Hostname field. Enter only the
computer name of the host in this required field.

+ You need to type a number in the Priority field only when creating a Failover Cluster
list to allow host failover feature. For details, please refer to “4.5.7 Configuring the
Failover Cluster List” on page 109.
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4. The newly added entry appears in the Host list.

® et R
® Atrust Client Setup | =W | NN [
Atrust Applications User Interface Derices Nemork System
Navigator | + Add H = Delete J
- hnet Hostname ¥ IP Address Alias / Group Priority
S WS2012R2RDSH WS2012R2RDSH 192,168.7.12  WS12 0
~-Host Name
Wireless
- Prowy

5. Repeat steps 2 through 3 to add another new entry.

6. Now you can use the name or alias of a host instead of its IP address wherever you need to specify an IP
address on Atrust Client Setup while configuring client settings.

Managing the Mapping List
To manage the Mapping list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

2. Select to manage entries on the Host list.

« To adjust the settings of an entry, double click the entry, or check off an entry, and then click the Edit
button on the top of the Mapping list.

« To delete an entry, check off the entry, and then click Delete on the top of the Mapping list.

+ To delete multiple entries, check off all the desired entries, and then click Delete. A window appears
prompting for confirmation. Click Yes to confirm.
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4.,5.7 Configuring the Failover Cluster List

Atrust Client Setup allows you to create the Failover Cluster list, maintaining the high availability of services from
that group of servers (failover cluster).

Creating the Failover Cluster List
To create a Failover Cluster list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

®) Atrust Client Setup o+
Atru St Applications User Interface Devices Network System
Navigator | + Add H = Delete |
~ Ethernet Hostname ¥ IP Address Alias / Group Priority
Hosts
Host Name
- Wireless
- Proxy

2. Click Add to start adding a new host entry.

3. Typein the name, IP address, alias and also cluster (group) name, priority order in the cluster (group), and
then click Save to apply.

~ Hosts Table Settings

Hostname: * |ADM1 | B
IP Address: * [192.168.7.21 | &
Alias / Group: |ADM | k&
Priority (1 | &

;——;J NOTE

« If your host belongs to a domain, please don't enter the FQDN (Fully Qualified
Domain Name) or full computer name in the Hostname field. Enter only the
computer name of the host in this required field.
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4. Repeat steps 2 though 3 to add another new entry.
5. All added entries appear on the Host list.

®) Atrust Client Setup o =llCS
Atru St Applications User Interface Devices Network System
Navigator | + Add ” = Delete |
- hnet Hostname ¥ IP Address Alias / Group Priority
ADM1 ADM1 192.168.7.21  ADM 1
- ADM2 ADM2 192.168.7.22  ADM 2
ADM3 192.168.7.23 ADM 3

- ADM3
~-Host Name
Wireless

- Promy

6. Your mt168L will follow the given priority order while connecting to this failover cluster (group).

Hostname % IP Address Alias / Group Priority
ADM1 192.168.7.21 ADM 1
ADM2 192.168.7.22 ADM 2
ADM3 192,168,7.23 ADM 2

Managing the Failover Cluster List
To manage the Host list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

2. Select to manage entries on the Host list.

« To adjust the settings of an entry, double click the entry, or check off an entry, and then click the Edit
button on the top of the Host list.
« To delete an entry, check off the entry, and then click Delete on the top of the Host list.

- To delete multiple entries, check off all the desired entries, and then click Delete. A window appears
prompting for confirmation. Click Yes to confirm.
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4,5.8 Changing the Host Name of Your Thin Client

To change the host name of your thin client, please do the following:

1. On Atrust Client Setup, click Network > Host Name.

2. Change the default host name of your thin client.

o Lllodimley
®) Atrust Client Setup o ol
Atrust Applications User Interface Derices Network System

General

- Ethernet

- Hosts - Name Setting
Host Name Host Name + [atrust-01FASL =
- Wireless
- Proxy * This setting will take effect after reboot.
| Save ] | Cancel

3. Click Save to confirm.

4. Arestart is required for the change to take effect.
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4.5.9 Enabling or Disabling the Wireless Interface

To enable or disable the wireless interface, please do the following:

%J’ NOTE

By default, the wireless interface is enabled.

1. On Atrust Client Setup, click Network > Wireless, and then click Wireless sub-tab.

o Ledl—dlmdis=d
®) Atrust Client Setup o ol
Atl'l.lSt Applicati User Interf: Devices Network System
Connections Wireless
Ethernet
PN ¢ Interface
Hosts .
" Host Name Enable wireless interface: Yes LI =
- Promwy
Save Cancel

2. Under the Interface section, click the drop-down menu to enable / disable the wireless network interface.

3. Click Save to apply.
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To configure the roaming trigger threshold for your wireless connection, please do the following:

1. On Atrust Client Setup, click Network > Wireless, and then click Wireless sub-tab.

Atrust

Navigator

- Ethernet
PN

-~ Hosts

-~ Host Name

- Proxy

Atrust Client Setup o alliCS
Applicati User Interf; Devices Network System
Connections Wireless
¢ Interface
Enable wireless interface: [ves -] I; ‘
¢ Roaming
‘ Roaming Signal Strength Trigger: |-70 dBm j = ‘

Save Cancel

2. Under the Roaming section, click the drop-down menu to choose the desired trigger threshold.

5/ NOTE

- To disable wireless roaming, you can choose No roaming here.

3. Click Save to apply.
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4.5.11 Establishing and Stopping a Wireless Connection

NOTE

+ Ensure that the wireless interface is enabled. Please refer to “Enabling or Disabling
the Wireless Interface” on page 112.

% :

Establishing a Wireless Network Connection
To establish a wireless network connection for your mt168L thin client, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

" LEEEE
®) Atrust Client Setup o =llCS
Atrust Applications  User Interface Devices Network System
Connections Wireless
- Ethernet
VPN + Add = Delete O‘:!: Scan
Hosts
- Host Name SSID Signal * Security Status Comment
le@ 100 WPA
Proxy Asus 2.4G 100 WeA
HTC Portable Hotspot AAFE 100 WRA
M%-1 100 WPA
StevenAP a7 WRA
MNETGEARSZ 84 Insecure
Mike - HTC D520 65 WPA
AndroidAP3104 48 WPA
guest00l 44 WPA
Autosetup 36 WPA
IT-APO2 36 WPA
TP-LINK_FO35F8 31 WPA
SMCWGBRLAS-M 20 WPA
testap 20 WPA
IT-APOL 20 WPA

+ Your mt168L will perform network discovery once and specify all available wireless
networks. To refresh, click Scan on the top of the Wireless Network list.

2. Click to check the desired wireless network. The Connect .~ Cennect button then appears on the top of the
Wireless Network list.
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o DEEEE
®) Atrust Client Setup o ol
Atl'l.lSt Applicati User Interf: Devices Network System
Navigator Connections Wireless
- Ethernet
VPN + Add = Delete ©) Scan ¥ Connect
Hosts
_~Host Name SSID Signal * Security Status Comment
IT-APO3 100 WPA
P
rony M1 100 WeA
HTC Portable Hotspot AAFE 96 WRA
IT-APOL 93 WPA
AndroidAP3104 77 WPA
guest00l 74 WPA
Autosetup 71 WPA
¥ IT-APD2 70 WPA
testap 69 WPA
Asus 2,4G 62 WPA
SMCWGBR145-N 58 WPA
Mike - HTC D620 48 WPA
(@_@) 46 WEA
TP-LINK_FO35F8 456 WPA
NETGEARS3 23 Insecure
dir-810-2g 15 WPA
Xperia Z1_bee? 4 WPA

3. Click Connect to create a wireless network connection through the selected wireless network.

4. A window appears prompting for confirmation or authentication.

%J’ NOTE

® Wireless Network Authentication Required

Authentication required by wireless network, Passwerds or encryption
keys are required to access the wireless network.

Wireless Security: [WPa & wPaA2 Personal |

Key: “[ ]

Show character

- If you ever accessed this wireless network before, the password will be automatically
recorded for future access. In this case, you don't need to provide the password
again; you only need to confirm the establishment of a wireless connection.

« Consult your network administrator for required information on authentication.

5. Type in the required password, and then click Connect to continue. Or, click OK to confirm the establishment

of a wireless connection.

6. Upon completion, the Status column of the wireless network will show connected.

SsSID Signal *~ Security Status Comment

(@_@) 100 WPA

IT-ARPD3 100 WP

IT-APD2 97 WPA connected  Connected before
Mike - HTC D620 a7 WP

testap 280 WPA

HTC Portable Hotspot AAF8 78 WPA

¥peria Z1_bee7 72 WPA

AndroidaP3104 71 WA

TP-LINK_FO35F8 70 WPA
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Stopping a Wireless Network Connection
To stop a wireless network connection, please do the following:
1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network. The Disconnect / Disconnect pytton appears on the top of the
Wireless Network list.

3. Click Disconnect to stop the wireless network connection.

Adding a Wireless Network
In case that you cannot find the desired wireless network in the Wireless Network list, you can manually add it.

To add a wireless network to the Wireless Network list, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.
2. Click Add on the top of the Wireless Network list.

3. On the opened window, type the wireless network name (SSID), select the used wireless security method,
and then provide the required information.

Confirm Dialog

You are going to connect this network.
Are you sure?

Wireless Network Name (SSID); *

Security: |Disab|e Encryption ;l

[ Connect H Cancel l

4. Click Connect to create a wireless connection.

NOTE

- For instructions on how to configure the IP address settings, please refer to section
“4.5.3 Configuring Wired Network Settings” on page 99.

i |

« The default is to use a dynamic IP address assigned by the DHCP server.

5. Upon completion, the added wireless network will be shown on the Wireless Network list and connected will
be shown on its Status column.

Deleting a Wireless Network
To delete a wireless network, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network, and then click Delete to remove the selected wireless network.

NOTE

+ Your mt168L detects available wireless networks automatically and put the
discovered networks on the Wireless Network list. A deleted wireless network may
therefore appear again on the list, but the connection settings, including the stored
authentication data, will be removed.

i |
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4.5.12 Configuring Wireless Connection Settings

Adjusting Connection settings for a Wireless Network
To adjust connection settings for a wireless network, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network which is currently connected. The Edit =~ .« Edit  button
appears on the top of the Wireless Network list.

3. Click Edit to adjust the settings:

- P
® Atrust Client Setup 1| =R | FEN (P
Atrust Applications  User Interface Devices Network System
- Ethernet
VPN ¢ Wireless Settings 5
- Hosts Wireless Network Name (SSID): * [maroz | &
- Host Name
Mode: [Managed =
- Proxy .
Connect automatically: |Enab\ed ﬂ ]
¢ Authentication
Security: [WPA & WPAZ Personal -] B
Network Key: * |n<»<>«)«)«»cmc | [
Save ] ‘ Cancel

+ On the General tab, click the drop-down menu to configure the automatic connection when this wireless
network is in range and other connection settings.

—=)) NOTE
=g
- By default, your client will connect to a wireless network automatically if it ever
connected to that network successfully.

« On the IPV4 Settings tab, click the drop-down menu or type values in fields to configure IP settings.

S NOTE
« For instructions on how to configure connection settings on the General tab, please
see section “4.5.11 Establishing and Stopping a Wireless Connection” on page 114.
For instructions on how to configure IP address settings on the IPV4 Settings tab,
please see section “4.5.3 Configuring Wired Network Settings” on page 99.

4. Click Save to apply.
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4.5.13 Configuring Proxy Settings for Web-based Access to Services

To configure proxy settings for Web-based access to services, please do the following:

NOTE

- Settings available here are only applicable to services that use Web-based access,
such as (Microsoft) Remote Web Access and (Citrix) Web Logon connection types.

=

1. On Atrust Client Setup, click Network > Proxy.

2. Click the Mode drop-down menu to select the desired configuration mode. Four modes are available:
No Proxy, Auto-detect proxy settings, Manual proxy configuration, and Auto proxy configuration.

=) NOTE

« The setting items will vary with the selected mode.

Gl

- Lalladl=le s
®) Atrust Client Setup o ol
Atru St Applications User Interface Devices Network System
- Ethernet
- Hosts  Connection Settings )
“ Host Name Mode: [Mo Proxy &
-~ Wireless

[PLReES * These settings are only applicable to services that use Web-based access, such as

(Microsoft] Remote Web Access and (Citrix) Web Logon connection types.

| Save H Cancel |
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3. Provide the data as required. Please refer to the following table for a description of each setting item.

Connection Settings

Item Description

Click to select the desired proxy configuration mode.

Mode Description

No Proxy Don’t use any proxy server.

Auto-detect proxy Detects the proxy settings for your network
Mode settings automatically.

Manual proxy

configuration Configures the proxy settings manually.

Auto proxy Loads proxy settings automatically through the
configuration connection to a proxy configuration file.

Mode: Manual proxy configuration

HTTP Proxy Provides the IP address of your HTTP proxy server.

Port Provides the port number which your HTTP proxy server uses.

Provides No Proxy list.

No Proxy for Don’t use any proxy server while connecting to the specified URLs.

Mode: Auto proxy configuration

Provides the URL of a proxy configuration file where proxy settings can be loaded

URL through the network.
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4.6 Configuring Service Access Settings

4.6.1 Applications Tab Overview

Applications tab enables you to configure settings for service access on clients. To access available settings of
Applications tab, click the tab on Atrust Client Setup.

Applications Tab Overview

9 EEEES

Atrust Client Setup

Atrust Applications User Interface Derices Network System

Remote Desktop ) ]
Citrix ICA sl . Remote Deskwp Avzilable Sessions: O X0

WMware View & Configure RDP (Remote Desktop Protocol) connection settings
S5H

Ciwix ICA Available Sessions: 0
Configure Citrix ICA connection settings

I YMware View Available Sessions: 0
— Configure VMware Wiew connection settings

SSH Available Sessions: 0
&F Configure SSH (Secure Shell) session settings

Interface Elements

No. Name Description

Click to select a setting item under Applications tab or to select a setting

1 Navigation area entry under a selected setting item.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4.6.2 Available Settings at a Glance

Tab Setting Icon Description Section Page

Click to configure RDP (Remote Desktop Protocol)

Remote Deskto T connection settings and create shortcuts on 222 1%%
P e the local desktop and START menu for Remote e
— ) 4.6.5 137
Desktop sessions.
4.6.6 152
Click to configure ICA (Independent Computing 4.6.7 165
Citrix ICA Architecture) connection settings and create 4.6.8 166
2 shortcuts on the local desktop and START menu 4.6.9 167
Applications for ICA sessions. 4.6.10 168
4.6.11 175
Click to configure VMware View connection 4.6.12 204
VMware View [ " | settings and create shortcuts on the local desktop  4.6.13 206
— and START menu for View sessions. 4.6.14 208
Click to configure SSH (Secure SHell) connection 4.6.15 213
SSH ol settings and create shortcuts on the local desktop 4616 515

and START menu for SSH sessions.
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4.6.3 Configuring Basic RDP Connection Settings

The Remote Desktop setting allows you to configure RDP (Remote Desktop Protocol) connection settings and
create shortcuts on the local desktop and START menu for service access. You can access remote desktops or
applications for work simply through these shortcuts.

NOTE

(W)

« For more information on Mirosoft Remote Desktop services, please visit Microsoft
website at www.microsoft.com.

Three connection types are available:

Connection Type Description Page
Remote Desktop Select to access remote desktop/application services. 123
Remote Web Access  Select to access remote application services through a Web browser. 125

Web Feed Select to access remote application services through published desktop shortcuts. 127


www.microsoft.com
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Connection Type: Remote Desktop
To quickly configure RDP connection settings for the Remote Desktop connection type, please do the following:

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

" Ll dlaled
® Atrust Client Setup Lalboullollles

Atl'l.lSt Applications User Interface Devices Network System
Remote Desktop ) v )
~Citrix ICA Session Name Server Address Connection Type

“WMware View

5/ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.

® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
Navigator General Options RD Gateway
Remote Desktop

- Citrix ICA ¢ Server Settings §

s WMware View Session Mame: * ‘ | [
Computer: & *

P X, 1%
Connection Type: \ Remote Desktop hd h
Network Level -
Authentication: [Enabled 1=
Server Authentication: ‘ Connect and don't warn me LI h
¢ Login Settings y
Username: | | =
Password: [ | |_
Domair: | | h
.'_ Use Smart Card Login
« Common Settings

Autostart When Startup: [Mo e
0on Application Exit: |Do MNothing e
Save l | Cancel

4. On General sub-tab, type in the session name and the server/virtual machine address under the Server
Settings section.

123
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NOTE

« The red asterisks indicate the required fields.

i

+ The remote service-hosted computer can be a physical server or a virtual machine.
Please visit Microsoft’s websites at www.microsoft.com or support.microsoft.com for
more information.

+ mt168L supports up to two Remote Desktop sessions at the same time.

« Windows® RemoteFX™ is the technology that offers a rich user experience over a
network for remote desktop users.

NOTE

il

- To create an entry of RDP connection settings for MultiPoint™ Remote Desktop
sessions, please do the following:

e
5 \-—{ to start discovering MultiPoint™

WMS

1. Inthe Server Settings section, click
Server systems over your network.

2. Inthe opened window, click the drop-down menu to select the desired
server, and then click OK to confirm.

3. The name and IP address of the selected server will be filled out in the
corresponding fields automatically.

« The default session name will be the name of the selected MultiPoint host server,
but you still can change the default.

+ Windows® MultiPoint™ Server is a shared resource technology. This Windows-based
operating system enables a host server to power multiple and independent stations,
allowing users to share the computing power of one single server. Based on this
operating system, Atrust offers a complete solution including both servers and
clients. For more information, please visit our website at www.atrustcorp.com.

5. Click Save to add this RDP connection entry.

6. The shortcuts for Remote Desktop services are automatically created on the local desktop and START menu.

NOTE

Wl

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.6.5 Configuring Advanced RDP Connection Settings” on page 137.
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Connection Type: Remote Web Access

To quickly configure RDP connection settings for the Remote Web Access connection type, please do the following:

5/ NOTE

+ Atrust mt168L supports only RD Web Access based on Windows Sever 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

- LllalEEE
® Atrust Client Setup Lalboullollles
Atl'l.lSt Applications User Interface Devices Network System
_
Remote Desktop " - :
~Citrix ICA Session Name Server Address Connection Type

- WMware View

%J‘ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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® Atrust Client Setup lla )l Cl
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
trix 1CA - Server Settings
VMware View Session Name: * &
Computer: *
P wag | =
Connection Type: \ Remote Desktop ;I h..
Network Level = =
Authentication: [Enabled R S

Server Authentication:

[Connect and don't warn me_~| l-..

- Login Settings
Username:

Password:
Domain:

._'_ Use Smart Card Login

® Atrust Client Setup ol E
Al:l'l.lSt Applications User Interface Devices Nework System
Navigator General Options RD Gateway
Remote Desktop
o Citrik ICA - Server Settings
s WMware View
L.55H ) )
Session Name: * | | =
Connection URL: * | | ‘_
Connection Type: [Remote Web Access - .__
- Common Settings
Autostart When Startup: [Mo d| l-..
0On Application Exit: |D0 Nothing j .-

Save l | Cancel

5. Type in the session name and connection URL through which Web-based remote applications is accessible.

5/ NOTE

« The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate connection URL.

6. Click Save to add this RDP connection entry.

7. The shortcuts for Remote Web Access are automatically created on the local desktop and START menu.
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Connection Type: Web Feed
To quickly configure RDP connection settings for the Web Feed connection type, please do the following:

5/ NOTE

+ Atrust mt168L supports only RD Web Feed based on Windows Sever 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

- LllalEEE
® Atrust Client Setup Lalboullollles
Atl'l.lSt Applications User Interface Devices Network System
_
Remote Desktop " - :
~Citrix ICA Session Name Server Address Connection Type

- WMware View

%J‘ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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® Atrust Client Setup N =N | W= | B
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
trix 1CA - Server Settings
VMware View Session Name: [ | h..
Computer: *
P wag | =
Connection Type: \ Remote Desktop ;I h..
Network Level = =
Authentication: [Enabled R S

Server Authentication: [Connect and don't warn me_~| l-..

- Login Settings
Username: |

Password: | | h.
Domain: | | =
._'_ Use Smart Card Login
- Common Settings
Autostart When Startup: |No i h..
On Application Exit: |Do Nothing i h..
Save l | Cancel
4. On General sub-tab, click the Connection Type drop-down menu to select Web Feed.
® Atrust Client Setup N =N | W= | B
l\tl'l.ISt Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
- Citrix ICA - Server Settings
WMware View
oSS Session Name: * | | =
web Feed URL: [ | &
Connection Type: |Web Feed i .-
- Login Settings )
Username: [ | .__
Password: | | h.
Domain: * | | h.
- RemoteApp and Desktop Connections
Update Now
Summary:
Last Update:
Save l | Cancel

5. Type in the session name, Web Feed URL through which remote applications is accessible, and your
credentials for Web Feed.

%J’ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate Web Feed URL.
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6. Click Update Now in the RemoteApp and Desktop Connections section. After completion, the result will be
shown as below in that section.

RemotefApp and Desktop Connections

Summary: 3 applications, 0 desktops
Last Update: Marn Jun 30 2014 10:13:16

%J’ NOTE

+ You can and need to use Update Now to refresh the Web Feed summary if there are
newly published applications. Otherwise, new applications will not be accessible.

7. Click Save to add this RDP connection entry.

8. Afolder named Work Resources with access shortcuts will be automatically created on the local desktop.

B2l | @ (Terminal]
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9. Access shortcuts for available applications can be found in that folder.

Work Resources - File Manager ool
File Edit View Go Help
& B 6 @|fhome!user!DesIaop!Work Resources/ §|
DEVICES
g B
@ File System
Calculator Paint WordPad

PLACES

@ user

:“-' Desktop

Trash

3 items (745 bytes), Free space: 390.2 MB

%J‘ NOTE

+ You need to use Update Now described in Step 6 to refresh the Web Feed if there
are newly published applications. Otherwise, new applications will not be shown.
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4.6.4 Accessing Remote Desktop Services

Connection Type: Remote Desktop
To access remote desktops, please do the following:

1. Double click the created shortcut on the desktop.
2. Follow the on-screen instructions and provide required credentials if needed.

3. The remote desktop will be displayed on the screen.

Example: Windows MultiPoint Server 2012

°
WMSUT &

Example: Windows Server 2012

B8 Windows Server 2012R2
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Example: Windows 8 Enterprise

= NOTE
)
+ The connection type of Remote Desktop also allow you to launch application-
only sessions; only a specific application is launched rather than a full desktop.

For details, please refer to section “4.6.5 Configuring Advanced RDP Connection
Settings”on page 137.



Connection Type: Remote Web Access
To access remote applications, please do the following:

1. Double click the created shortcut on the desktop.

2. A window appears prompting for credentials.

Work Resources

(2¢) RemoteApp and Desktop Connection

Configuring Client Settings

Configuring Service Access Settings

his web page, you
complies with your

‘@/ NOTE

« A warning message “This Connection is Untrusted” might appear. Consult the
IT administrator for details and ensure the connection is secure first. To import
a security certificate, please refer to section “4.2.16 Importing Certificates for
Remote Computers” on page 71.To bypass, click | Understand the Risks > Add

Exception > Confirm Security Exception.

& ¥ TIP

- To exit this Logon screen or other screens and return to the local desktop, please

press Alt + F4.

3. Provide your credentials, and then click Sign in.
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4. Access shortcuts will be shown on the screen.

Work Resources -

RemoteApp and Desktop Connection

RemoteApp and Desktops Help  Sign out

Current folder: /

Wordpa

Current folder: /

fa_

Iy

Calculator Paint

5. Click or Double-click to select the desired application.

6. A window appears prompting for credentials.

- Windows Security i
Enter your credentials

These credentials will be used to connect to
VRDWEB12RZ2.RDWEB.FOC: 3389,

7. Provide your credentials, and then click OK to launch the selected application.

Q/ TIP

+ Use Alt + Tab to select and restore a hidden or minimized application or desktop.
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Connection Type: Web Feed

1. Double click Work Resources folder on the local desktop.

Atrust

| @ trerminai)

2. Access shortcuts for available applications can be found in that folder.

Work Resources - File Manager

File Edit View Go Help
& 5 4 Q|fhome;’userlDesIaop;’Work Resources/

DEVICES )
g B
@ File System
Calculator Paint WaordPad

PLACES

@ user

G “ Desktop

Trash

3 items (745 bytes), Free space: 390.2 MB

3. Double-click to select the desired application.
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4. A window appears prompting for credentials.

o " EEd
- Windows Security vl
Enter your credentials

These credentials will be used te connect to
VRDWEB1 2R2.RDWERB.POC: 3389,

Username: o D
Password: :]
Domain: :]

5. Provide your credentials, and then click OK to launch the selected application.

Remote Application Examples
Mozilla Firefox and Calculator

@ MoilaFirefox tart Page

Fle Edt View Go Help
€ & & O[5 /momefuser/Desktop/Work Resources/
DEVICES

_— e 9
~ 5 “ File System -
Google Caledlator  Mozilla Firefox Paint
PLACES
() GrmRs s Do =

() Desktop WordPad

¥ * O % O @ rreminn &

Downloads  Bookmarks  History Add-ons Sync

Choose What I Share | %

Calculator
View Edit Help

"Calculator” (251 bytes) desktop configuration file

Bl | caicutator @ Mozila Firefox Start

. | & [Terminal] [ Work Resources - File..
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4.6.5 Configuring Advanced RDP Connection Settings

The tables below provide a description of each setting item for RDP connections. Please refer to these tables to
configure advanced settings and customize shortcuts on local desktop and START menu for service access.

NOTE

(]

« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Remote Desktop

= NOTE
— - For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 145.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 148.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Desktop sessions.
C Type in the computer name or IP address of the server where to deliver a
omputer .
Remote Desktop session.
This table only provides descriptions for available settings when Remote
Desktop is selected.
Three connection types are available:
Option Description
Connection Type Remote Desktop Select to access remote desktop/application services.
Remote Web Access Select to access remote application services through

a Web browser (Mozilla Firefox).

Select to access remote application services through
Web Feed published desktop shortcuts.

Select to enable/disable Network Level Authentication.

NOTE: Network Level Authentication is the authentication method used to
enhance the server security by requiring that the user be authenticated
before the logon screen is displayed and a session is created. This is a
more secure authentication method that can help protect the remote
computer from malicious users and software.

Network Level Authentication
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Server Authentication

Select what to do next if the client cannot verify the identity of the remote
computer. Three options are available: Connect and don’t warn me,
Warn me, and Do not connect.

Option Description

Connect and don't Connects anyway without any warning.

warn me
Warns and allows users to choose whether t
Warn me a and allo o choo (o]
connect or not.
Do not connect Disallows the connection.

NOTE: To import certificates for remote computers, please refer to section
“4.2.16 Importing Certificates for Remote Computers” on page 71.

Login Settings

Item Description
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Type in the domain of the server.
Domain NOTE: Domain is a collection of computers on a network that share a common

database and security policy. Leave this field blank if the server doesn’t

belong to any domain.

Use Smart Card Login

Check to enable logon with a smart card.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
mt168L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description
The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.
Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

2 Autostart

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:

e Returning to the local desktop
e Re-launching a new session

e Restarting the thin client

e Turning off the thin client

3 Quick Connection

The client will enter Atrust Quick Connection
screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a Remote Desktop session is ended. Five options are
available: Do Nothing, Restart Application, Force-Restart Application,

Reboot, and Shutdown.

Option

Description

Do Nothing

Returns to the mt168L local Linux desktop.

Restart Application

Opens a Remote Desktop session again.

Force-Restart Application

Opens a Remote Desktop session again and
skips any messages in-between.

Reboot

Restarts your mt168L.

Shutdown

Turns off your mt168L.
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Options Sub-tab

Programs

Item

Description

Start the following program on
connection

Click the drop-down menu to enable or disable the Application mode. Use this
option to select the session type. Two remote session types are available:

e Remote Desktop (when the Application mode is disabled)
e Remote Application (when the Application mode is enabled)

NOTE: Remote Application sessions are Remote sessions used to access only
specific applications rather than full desktops.

NOTE: Before you can open a Remote Application session, you need to add the
desired application to the RemoteApp Programs list with RemoteApp
Manager on the host server. For detailed instructions on how to add a
desired application to the RemoteApp Programs list on the server, please
visit Microsoft’s website at www.microsoft.com.

Start in the following folder

Type in the location of the desired application (on the host server) if Start the
following program on connection is enabled.

NOTE: You can type in the location/path of the desired application in this field,
and specify only the name of the application in Program path and file
name (the next field). Or, you can type in the full path and name of the
application in Program path and file name, and leave this field empty.

Program path and file name

Type in the name of the desired application if Start the following program on
connection is enabled.

Remote APP Format Example

Windows Media Player C:\Programs Files (x86)\Windows Media Player\wmplayer.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32

NOTE: the file extension can be omitted.

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Five options are available: Automatic, 15 Bit, 16 Bit, 24 Bit,
and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: The Automatic option uses the setting defined by the host server.
NOTE: You can configure the upper limit of the color depth for a Remote Desktop

session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.
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Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Four options are available: Fullscreen, Large Window,
Medium Window, and Small Window.

Option Description

Opens a Remote Desktop session in full screen with the same

Fullscreen display resolution as the local desktop.

Large Window Opens a Remote Desktop session in a large display resolution.

Medium Window Opens a Remote Desktop session in a medium display resolution.

Small Window Opens a Remote Desktop session in a small display resolution.

NOTE: To configure the display resolution of the local desktop, please refer to
section “4.3.3 Configuring Display Settings” on page 77.

Use Toolbar

Click the drop-down menu to select whether to use the Atrust Toolbar on a
Remote Desktop session. The tool bar allows you to adjust a session window size
or suspend a session.

Atrust & %

Cursor Auto-hide

Click the drop-down menu to enable/disable the auto-hiding of the mouse cursor
or pointer on inactivity in Remote Desktop sessions.

Use RemoteFX

Click the drop-down menu to disable/enable RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: To enable the RemoteFX feature for Remote Desktop sessions on your
mt168L thin client, you still need to configure the host server. For
detailed instructions on how to enable RemoteFX on a host server, please
visit Microsoft Support website at support.microsoft.com.

Progressive Rendering

Click the drop-down menu to disable/enable progressive rendering.

When enabled, images and videos will be encoded and sent over progressively
when the network bandwidth is limited. This new RemoteFX feature is supported
by Windows Sever 2012 and Windows 8.

NOTE: This option is shown only when Use RemoteFX is enabled.

Use Bulk Compression

Click to enable/disable the bulk compression for the data traffic between the
server and client.
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Optimization Settings

Item

Description

Connection Quality

Select the option that best describes the quality of your network connection.
Three options are available: LAN (Very Fast), Broadband (Fast), and
Modem (Slow).

NOTE: Selection here will determine the defaults of items in this section as
listed below.

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Visual styles

Check to allow non-classic themes.

Persistent bitmap caching

Check to allow client-side cache of bitmaps for a session.

Connection Settings

Item

Description

Multimedia Redirection

Click the drop-down menu to disable/enable multimedia redirection.

When enabled, the client receives original compressed multimedia streams and
decodes locally for display. This feature increases the load on the client, but
saves server resources, decreases the bandwidth usage, and improves audio and
video playback experiences.

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in a Remote Desktop session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in a Remote Desktop session.
The default is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
"4.4.3 Configuring Settings for USB Storage Devices” on page 89.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add a local or network printer for your mt168L first, and then
enable this feature here to use that printer in a Remote Desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
mtl168L, please refer to section “4.4.7 Adding a Local Printer” on page
93 or “4.4.8 Adding a Network Printer” on page 96.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in a Remote Desktop session.
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Parallel Port Mapping

Click the drop-down menu to enable/disable parallel port mapping.

When Enable is selected, users can access a parallel device, such as a printer or
scanner, in a Remote Desktop session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in a Remote Desktop session.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in a Remote Desktop

Play on this computer session using locally attached audio devices.

Allows audio playback in a Remote Desktop
Play on remote computer  session using audio devices attached to the
remote computer.

Disables audio playback in a Remote Desktop

Do not play session using locally attached audio devices.

Remote Audio Recording

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description
Recording from this Allows audio recording in a Remote Desktop
computer session using locally attached audio devices.

Disables audio recording in a Remote Desktop

Do not record session using locally attached audio devices.
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RemoteFX USB Redirection Settings

Item

Description

Use RemoteFX USB Redirection

Check/Uncheck to enable/disable locally attached USB devices in a Remote
Desktop session (virtual machine based only).

NOTE: RemoteFX USB Redirection allows the redirection of USB devices into
server-hosted virtual machines (with guest operating systems).

NOTE: RemoteFX USB Redirection is only applicable to the virtual machine based
Remote Desktop service not to session based one. For more information,
please visit Microsoft Support website at support.microsoft.com.

On the client side, please do the following to enable locally attached USB devices
in a virtual machine based desktop:

1. Ensure that the desired USB device has been connected to your client.

. Ensure that RemoteFX is enabled on your mt168L (see “Use RemoteFX"”
on page 141).
3. Click to check Use RemoteFX USB Redirection.

4. A new checkbox appears with the required device driver. Check to enable
the driver.

5. Click Save to apply.

NOTE: You also need to configure the host server and its guest OSs to enable
RemoteFX USB Redirection in a Remote Desktop session. For instructions

on server-side configuration, please visit Microsoft Support website at
support.microsoft.com.

RD Gateway Sub-tab

Connection Settings

Item

Description

Use RD Gateway server

Check/Uncheck to enable/disable the use of an RD Gateway server. When
checked, the following two items in this table appear.

Server Name

Type the name of the RD Gateway server. Ask the network administrator for
this information.

Use my Remote Desktop
credentials for the RD Gateway

Check to use the same set of credentials for authenticating to both the Remote
Desktop computer and the RD Gateway server.

Bypass RD Gateway for
local address

Check to prevent traffic to and from local network addresses from being routed
through the RD Gateway server. This could make your RDP connection faster.
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Settings for the Connection Type of Remote Web Access

=) NOTE

- For descriptions of settings for the connection type of Remote Desktop, please refer
to “Settings for the Connection Type of Remote Desktop” on page 137.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 148.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Web Access sessions.
Connection URL Type in the URL of the server where to deliver Remote Web Access sessions.

This table only provides descriptions for available settings when Remote
Web Access is selected.

Three connection types are available:

Option Description

Connection Type Remote Desktop Select to access remote desktop/application services.

Select to access remote application services through

Remote Web Access a Web browser (Mozilla Firefox).

Select to access remote application services through
Web Feed published desktop shortcuts.
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Common Settings

Item Description

Select whether to open a Remote Web Access session automatically or not when
mt168L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Select what to do when a Remote Web Access session is ended. Five options
are available: Do Nothing, Restart Application, Force-Restart Application,
Reboot, and Shutdown.

Option Description
Do Nothing Returns to the mt168L local Linux desktop.
On Application Exit Restart Application Opens a Remote Web Access session again.

Opens a Remote Web Access session again and

Force-Restart Application skips any messages in-between.

Reboot Restarts your mt168L.

Shutdown Turns off your mt168L.
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Options Sub-tab

% ) NOTE
— - No options are available under the Options sub-tab in the connection type of
Remote Web Access.
RD Gateway Sub-tab
=) NOTE
7

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.



148 | Configuring Client Settings

Configuring Service Access Settings

Settings for the Connection Type of Web Feed

=

General Sub-tab

NOTE

For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 137.

For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 145.

Server Settings

Item

Description

Session Name

Type in the name for Web Feed sessions.

Web Feed URL

Type in the URL of the server where to deliver Web Feed sessions.

Connection Type

This table only provides descriptions for available settings when Web Feed
is selected.

Three connection types are available:

Option Description

Remote Desktop Select to access remote desktop/application services.

Select to access remote application services through

Remote Web Access a Web browser (Mozilla Firefox).

Select to access remote application services through

Web Feed published desktop shortcuts.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

RemoteApp and Desktop Connections

Item

Description

Update Now

Click to fetch and update the published applications list from the server.
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Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Five options are available: Automatic, 15 Bit, 16 Bit, 24 Bit,
and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: The Automatic option uses the setting defined by the host server.
NOTE: You can configure the upper limit of the color depth for a Remote Desktop

session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Cursor Auto-hide

Click the drop-down menu to enable/disable the auto-hiding of the mouse cursor
or pointer on inactivity in Remote Desktop sessions.

Use RemoteFX

Click the drop-down menu to disable/enable RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: To enable the RemoteFX feature for Remote Desktop sessions on your
mt168L thin client, you still need to configure the host server. For
detailed instructions on how to enable RemoteFX on a host server, please
visit Microsoft Support website at support.microsoft.com.

Use Bulk Compression

Click to enable/disable the bulk compression for the data traffic between the
server and client.

Optimization Settings

Item

Description

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Visual styles

Check to allow non-classic themes.

Persistent bitmap caching

Check to allow client-side cache of bitmaps for a session.
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Connection Settings

Item

Description

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in a Remote Desktop session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in a Remote Desktop session.
The default is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
“4.4.3 Configuring Settings for USB Storage Devices” on page 89.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add a local or network printer for your mt168L first, and then
enable this feature here to use that printer in a Remote Desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt168L, please refer to section “4.4.7 Adding a Local Printer” on page
93 or “4.4.8 Adding a Network Printer” on page 96.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in a Remote Desktop session.

Parallel Port Mapping

Click the drop-down menu to enable/disable parallel port mapping.

When Enable is selected, users can access a parallel device, such as a printer or
scanner, in a Remote Desktop session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in a Remote Desktop session.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in a Remote Desktop

Play on this computer session using locally attached audio devices.

Allows audio playback in a Remote Desktop
Play on remote computer  session using audio devices attached to the
remote computer.

Disables audio playback in a Remote Desktop

Do not play session using locally attached audio devices.
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Remote Audio Recording

Click the drop-down menu to configure the audio playback setting in a Remote

Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description

Recording from this

Allows audio recording in a Remote Desktop
computer

session using locally attached audio devices.

Do not record Dlsaples agdlo recording in a Rempte Dgsktop
session using locally attached audio devices.

RemoteFX USB Redirection Settings

Item

Description

Use RemoteFX USB Redirection

Check/Uncheck to enable/disable locally attached USB devices in a Remote
Desktop session (virtual machine based only).

NOTE: RemoteFX USB Redirection allows the redirection of USB devices into
server-hosted virtual machines (with guest operating systems).

NOTE: RemoteFX USB Redirection is only applicable to the virtual machine based
Remote Desktop service not to session based one. For more information,
please visit Microsoft Support website at support.microsoft.com.

On the client side, please do the following to enable locally attached USB devices
in a virtual machine based desktop:

1. Ensure that the desired USB device has been connected to your mt168L.

. Ensure that RemoteFX is enabled on your mt168L (see “Use RemoteFX”
on page 141).

3. Click to check Use RemoteFX USB Redirection.

A new checkbox appears with the required device driver. Check to enable
the driver.

5. Click Save to apply.

NOTE: You also need to configure the host server and its guest OSs to enable

RemoteFX USB Redirection in a Remote Desktop session. For instructions

on server-side configuration, please visit Microsoft Support website at
support.microsoft.com.

RD Gateway Sub-tab

NOTE

I

+ No options are available under the Options sub-tab in the connection type of
Web Logon.

151


support.microsoft.com
support.microsoft.com

152 | Configuring Client Settings

Configuring Service Access Settings

4.6.6 Configuring Basic ICA Connection Settings

The Citrix ICA setting allows you to configure ICA connections for Citrix services and create shortcuts on the local
desktop and START menu for service access. You can access virtual desktops and applications for work simply

through these shortcuts.

NOTE

@I

« For more information on Citrix desktop virtualization solutions, please visit Citrix
website at www.citrix.com or Citrix Knowledge Center at support.citrix.com.

Six connection types are available:

Connection Type Description
Web Logon Select to access desktop/application services through a Web browser.
StoreFront Select to access desktop/application services through a StoreFront.
VDI-in-a-Box Select to access desktop services through VDI-in-a-Box.
XenDesktop Select to access desktop services through an earlier version of XenDesktop.
XenApp Select to access application services through an earlier version of XenApp.
Server Connection Select to access service delivery servers (XenApp servers only).
= NOTE
7

+ You can refer to the following table for Citrix products and recommended
connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon

Page
153
155
157
159
161

163



Configuring Client Settings | 153

Configuring Service Access Settings

Connection Type: Web Logon
To quickly configure ICA connection settings for the Web Logon connection type, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

" Ll dlaled
® Atrust Client Setup Lalboullollles

Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop

_ Citrix ICA + Add — Delete
s WMware View

L 55H

Session Name ¥ Server Address Connection Type

%J‘ NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.



154 | Configuring Client Settings

Configuring Service Access Settings

4. On General sub-tab, leave the connection type as Web Logon as default, and then type in the desired
session name and the IP address / URL / FQDN of the server through which Citrix services are accessible.

D Gl anl St
® Atrust Client Setup L =)

Al:l'l.lSt Applications User Interface Devices Newwork System

General Options

¢ Server Settings

Session Name: * | | =
Connection Type: |Web Logon ;| =
Server Address: * | | [

« Common Settings

Autostart When Startup: |N0 i

on Application Exit: |DU Nothing e

Save l | Cancel

NOTE

« For newer versions of XenDesktop and XenApp, you may need to further specify
the sub-path of the server. Refer to the following table for details:

i)

Component to

Citrix Product Connect

Connection Address

XenApp 6.5 or

earlier Web Interface IP / URL / FQDN

XenDesktop 5.6

or earlier Web Interface  IP / URL / FQDN

IP / URL / FQDN plus sub-path

For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenApp and
XenDesktop 7.5

- FQDN is the acronym of Fully Qualified Domain Name.

5. Click Save to add this ICA connection entry. The access shortcuts are automatically created on the local
desktop and START menu.

NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 175.
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Connection Type: StoreFront
To quickly configure ICA connection settings for the connection type of StoreFront, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

allt]

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, Click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
— 0 + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

N

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select StoreFront.

- e
® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
General Options
- Remote Desktop
Citrix [CA ¢ Server Settings .
o WMware View Session Mame: [ | &
L. g5H
Connection Type: [storeFront hd 'S
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Desktop Group / Application: "\g}% * | | e
« Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual applications/
desktops are accessible, and the name of desktop group or application.

=) NOTE
=
+ You can use the Search icon Qg to help you discover available desktop groups or
applications for a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 175.
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Connection Type: VDI-in-a-Box
To quickly configure ICA connection settings for the connection type of VDI-in-a-Box, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, Click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
— 0 + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select VDI-in-a-Box.

- e
® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
General Options
- Remote Desktop
Citrix [CA ¢ Server Settings .
o WMware View Session Mame: [ | &
L. g5H
Connection Type: [VDHin-a-Box hd 'S
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Desktop Group: "\g}% * | | &
« Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual desktops are
accessible, and the name of the desktop group.

=) NOTE
=
+ You can use the Search icon Qg to help you discover available desktop groups for
a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 175.
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Connection Type: XenDesktop
To quickly configure ICA connection settings for the connection type of XenDesktop, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
— 0 + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select XenDesktop.

- e
® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
General Options
- Remote Desktop
Citrix ICA ¢ Server Settings \
o WMware View Session Mame: [ | &
L. g5H
Connection Type: [¥enDesktop hd 'S
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Desktop Group: "\g}% * | | ]
« Common Settings
Autostart When Startup: |N0 e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual desktops are
accessible, and the desired desktop group.

NOTE

&

+ You can use the Search icon Qg to help you discover available desktop groups for
a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 175.
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Connection Type: XenApp
To quickly configure ICA connection settings for the connection type of XenApp, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

allt]

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

> R
® Atrust Client Setup plcll=llies
Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop
— 0 + Add — Delete
s WMware View

Session Name ¥ Server Address Connection Type

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

N

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select XenApp.

= - Ladlodlmllead
® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
General Options
- Remote Desktop
Citrix ICA ¢ Server Settings
- VMware View Session Mame: [ | &
L. g5H
Connection Type: [xenapp hd 'S
Server Address: * | | =
Username: | | [
Password: [ | =
Domain: | | [
Application Name: "\E;)'% * | | E
« Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Manual Parameters: [ | =
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual applications are
accessible, and the desired application name.

=) NOTE
=
+ You may need to provide the XML port number as well for your server address
(for example, XA65P.CTX.poc:8080), depending on your server-side configuration.
=) NOTE
=

+ You can use the Search icon O% to help you discover available applications for a
given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 175.
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Connection Type: Server Connection
To quickly configure ICA connection settings for the connection type of Server Connection, please do the following:

5/ NOTE

- This connection type is used to connect to XenApp server for administration and
supports only XenApp 6.5 and earlier.

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

. A
® Atrust Client Setup Lalboullollles

Atru‘—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop

_ Citrix ICA + Add — Delete
S WMware View

.5SH

Session Name ¥ Server Address Connection Type

%J‘ NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select Server Connection.

- e
® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Newwork System
General Options
- Remote Desktop
Citrix ICA ¢ Server Settings \
o WMware View Session Mame: [ | &
L. g5H
Connection Type: [server connection hd 'S
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Server Name: "\E;)'% | | ]
« Common Settings
Autostart When Startup: |N0 e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, server address, and server name.

=) NOTE
=
+ You may need to provide the XML port number as well for your server address
(for example, 192.168.77.10:8080), depending on your server-side configuration.
=) NOTE
=

+ Only connections to XenApp servers are supported by this connection type.

+ You can use the Search icon O% to help you detect the server name.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

j NOTE
- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.6.11 Configuring Advanced ICA Connection Settings” on page 175.
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4.6.7 Switching the Citrix Receiver Version

Two versions of Citrix Receiver are switchable in case that an older version of Citrix Receiver is required for your
Citrix environment.

To change the version of Citrix Receiver, please do the following:

NOTE

]

- This is a global setting; the change will affect all Citrix connections.

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click the drop-down menu to select the desired Citrix Receiver version. Two options are available:
12.xand 13.x.

® Atrust Client Setup Lalboullallies
Al:l'l.lSt Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA - Common Settings )
WMware View - . .
. SSH Citrix Receiver Version: |13,>< j [
Use Esc to quit Web Logon: |Yes j =
Keyboard Layout Depends on: |Loca| j =
Keyboard Type: |Default j [

* The change to the used Receiver version will affect all sessions.

* All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

<\/ TIP

« The default Citrix Receiver version is 13.x.

+ You can refer to the following table for Citrix products and recommended Citrix
Receiver version:

Citrix Product Recommended Receiver Version
XenApp earlier than 6.5 12.x
XenDesktop earlier than 5.6 12.x
XenApp / XenDesktop 7.x or later 13.x

3. Click Save to apply.
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4.6.8 Enabling or Disabling Esc to Quit on the Web Logon Screen

You can choose whether to allow the use of Esc key to quit the Web Logon screen:

If Yes is selected, you can use both Esc and Alt + F4 to quit the Web Logon screen.

- If Nois selected, only Alt + F4 works.

To enable or disable Esc to Quit on the Web Logon screen, please do the following:

allt]

NOTE

- This is a global setting; the change will affect all Citrix connections.

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click the drop-down menu to select Yes or No to enable or disable Esc to Quit.

Atrust

WVMware View
S5H

Atrust Client Setup v llo L]
Applications User Interface Derices Nemwork Sysem
Sessions Global
« Common Settings g
Citrix Recelver Version: [13.x -l e
Use Esc to quit Web Logon: |Yes j =
Keyboard Layout Depends on: |L0ca| j =
Keyboard Type: |Default j [
* The change to the used Receiver version will affect all sessions.
* All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

3. Click Save to apply.
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4.6.9 Configuring Keyboard Layout and Type for Citrix ICA Sessions

To set the used keyboard layout and type for all Citrix ICA sessions, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click drop-down menus to select what determines the keyboard layout and the desired keyboard type.

® Atrust Client Setup N =N | W= | B
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA - Common Settings
WMware View - . . ~
S5H Citrix Receiver Version: |13.x j e
Use Esc to quit Web Logon: |\«’es j E
Keyboard Layout Depends on: |Loca| j h.
Keyboard Type: |Default j B
* The change to the used Receiver version will affect all sessions.
* All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

—)) NOTE
=

« These are global settings; the changes will affect all ICA sessions.

3. Click Save to apply.
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4.6.10 Accessing Citrix Services

For Connection Types of StoreFront, VDI-in-a-Box, XenDesktop, XenApp, and Server Connection
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop, and then provide your credentials if needed.

2. The desired desktop or application will be displayed on the screen.

For Connection Type of Web Logon
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

2. The Web browser is launched in full-screen with the Citrix Logon screen.

Citrix Logon Screen Example: XenApp 6.0 Fundamentals

Citrix Logon Screen Example: XenApp 6.5 Platinum

Citrix XenApp

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

CITRIX' [o%]
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Citrix Logon Screen Example: XenDesktop 5.6 Platinum

Citrix XenDesktop

‘Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

CITRIX" [0x]

Citrix Logon Screen Example: VDI-in-a-Box

Citrix Receiver
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Citrix Logon Screen Example: XenApp and XenDesktop 7.5 Platinum

Citrix Receiver

3. Typein the required credentials, and then click Log On.

NOTE

- If your XenApp server doesn’t belong to any domain, type in the server name in the
Domain field instead.

[l
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4. On the Desktop or Application Selection screen, click to select the desired desktop or application(s).

@ NOTE

+ You might enter the virtual desktop directly if only one type of virtual desktop is
assigned to the provided credentials.

Selection Screen Example: XenApp 6.5 Platinum

Search 4 a i -
B Logged on as:CTxAl sefis | logon~  CHRIX

= e
<) @

Notepad FDF Reader X PR Viewer 2007

Hint: ik D 10 pause any runming

Selection Screen Example: XenDesktop 5.6 Platinum

CITRIX'

Settings Log Off

W7Ue WS2KBR2e
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Selection Screen Example: XenApp 7.5 Platinum

Selection Screen Example: XenDesktop 7.5 Platinum
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5. The selected virtual desktop or application(s) will be displayed on the screen.

Virtual Application Examples
PowerPoint Viewer, Adobe Reader, and Notepad

P—— LB cmx

Il

File Edt View Window Help
Dl

RAFBEX |

Tools i Sign i Comment

ADOBE' READER X

Open a Recent File Acrobat.com Services

Open. @ CreatePDF Online
] Convert PDF to Word or Exce Online
% Share Files Using Sendiow Online

@ Get Documents Signed

i [Fowmens 5] @3 2@

Hame -+ || Date modfied || Type 1=
N items fatch your search,

wur PDF File:

Jey Note and Highlighter
ments to your FOF

gl | o

Fi name: 2 Dpen

Files o type: FowerPaint Presertalions ~ E=)
%

Virtual Application Examples
Adobe Reader, Mozilla Firefox, and PowerPoint Viewer

CitrixReceiver

@ MosilaFifocstartPage % |

Vindow_Help

poaments &) ) [ @ [ & [

Search

Open a Recent File Adobe Online Services

@ W Conputer @) Convet#05toVrdor
22 Acosacom

2 Creste OF

Send. kFileOnline.
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Virtual Desktop Example
Windows 7 Ultimate

Welcome to your Citrix XenDesktop

Any Device

Access is easyfrom any PG,
Wac, smartphone or tablet
The choice s yours.

Welcome to the virtual workstyle -
Your desktop, apps and documents at your fingertips :E;::::::):andsmnm

leskiop, and the freedom to do whatever, whenever, graphics over any network,
it including Wi-Fi or 3

W Dont show the welcome screen again.

S ) B35
2O

Virtual Desktop Example
Windows Server 2008 R2

0> L3k

=il
|
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4.6.11 Configuring Advanced ICA Connection Settings

The tables below provide a description of each setting item for ICA connections. Please refer to these tables to
configure advanced settings and customize shortcuts on the local desktop and START menu for service access.

—=)) NOTE
w/f
« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Web Logon

=) NOTE
7
- For descriptions of available settings for the connection type of StoreFront, please
refer to “Settings for the Connection Type of StoreFront” on page 179.

- For descriptions of available settings for the connection type of VDI-in-a-Box, please
refer to “Settings for the Connection Type of VDI-in-a-Box” on page 184.

- For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 189.

« For descriptions of settings for the connection type of XenApp, please
refer to “Settings for the Connection Type of XenApp” on page 194.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 199.
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General Sub-tab

Server Settings

Item Description

Session Name Type in the name of browser sessions for Citrix service access.

This table only provides descriptions for available settings when Web Logon
is selected.

Six connection types are available:

Option Description
Web Logon Provides access to virtual desktops and applications

9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications

through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.
. Provides access to virtual applications for an earlier
Connection Type XenApp version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon

Type in the IP address / URL / FQDN of the server through which Citrix services
are accessible.

Refer to the table below for details:

Component to

Connect Connection Address

Citrix Product

XenApp 6.5 or Web Interface  IP/ URL / FQDN

earlier
Server Address
XenDesktop 5.6 \yop 1nterface 1P/ URL / FQDN
or earlier
IP / URL / FQDN plus sub-path
XenApp and For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenDesktop 7.5
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Common Settings

Item Description

Select whether to open a browser session for Citrix service access automatically
or not when your mt168L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Select what to do when a browser session for Citrix service access is ended.
Four options are available: Do Nothing, Restart Application, Reboot, and

Shutdown.
Option Description
Do Nothing Returns to the Local Linux desktop.

On Application Exit

Restart Application  Opens a browser session again for service access.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB
drive(s) and to select access type in a Citrix ICA session. Three options are
available: No, Read Only, and Read Write. If Read Only or Read Write is
selected, the locally attached USB drive(s) will become available in launched
Citrix ICA sessions.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial
device(s) in a Citrix ICA session. If Yes is selected, the locally attached serial
device(s) will become available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt168L. However, if you use a
serial-based barcode scanner, and attach it to your mt168L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s)
in a Citrix ICA session. If Yes is selected, the locally attached printer(s) will
become available in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 93 for detailed instructions.

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 62 for detailed instructions on these similar settings.
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General Sub-tab

NOTE
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For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 175.

For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 184.

For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 189.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 194.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 199.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

is selected.

This table only provides descriptions for available settings when StoreFront

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Type in the IP address / URL / FQDN of the server through which virtual desktops

Server Address or applications are accessible (where a StoreFront is hosted).

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.

Domain Type in the domain of the server.

Desktop Group / Application Type in the name of the desktop group / application or use the Search icon O

in front of the field to discover available desktop groups / applications.

Common Settings

Item Description

Select whether to open a Citrix ICA session automatically or not when your
mtl68L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and
800x600.
) Click the drop-down menu to select the desired window mode. Two options are
Window Mode

available: Regular Window and Seamless Window.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt168L. However, if you use a
serial-based barcode scanner, and attach it to your mt168L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 62 for detailed instructions on these similar settings.
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Settings for the Connection Type of VDI-in-a-Box

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 175.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 179.

For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 189.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 194.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 199.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

is selected.

This table only provides descriptions for available settings when VDI-in-a-Box

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
are accessible.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group / Application

Type in the name of the desktop group or use the Search icon O\g in front of the
field to discover available desktop groups.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mtl68L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.

Options Sub-tab

Window Settings

Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt168L. However, if you use a
serial-based barcode scanner, and attach it to your mt168L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @a moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on

page 62 for detailed instructions

on these similar settings.
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Settings for the Connection Type of XenDesktop

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 175.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 179.

For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 184.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 194.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 199.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

selected.

This table only provides descriptions for available settings when XenDesktop is

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
are accessible (where a Web Interface is hosted).

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group

Type in the name of the desktop group or use the Search icon O\g in front of the
field to discover available desktop groups.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mtl68L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt168L. However, if you use a
serial-based barcode scanner, and attach it to your mt168L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 62 for detailed instructions on these similar settings.
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Settings for the Connection Type of XenApp

=) NOTE

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 175.

- For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 179.

- For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 184.

- For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 189.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 199.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when XenApp
is selected.

Six connection types are available:

Option Description

Provides access to virtual desktops and applications

Web Logon through the interface of a Web browser (Mozilla Firefox).

Provides access to virtual desktops and applications

Storefront through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.
. Provides access to virtual applications for an earlier
Connection Type XenApp version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of a XenApp server.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Application Name

Type in the application name or use the Search icon O\g in front of the field to
discover available applications.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mtl68L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.

Manual Parameters

Type in parameters for extended parameter passing.

Options Sub-tab

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: 16 Bit, 24 Bit, and Automatic.

Window Size

This item is available only when Regular Window is selected.

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Four options are available: Full Screen, 1280x1024, 1024x768, and
800x600.

Window Mode

Click the drop-down menu to select the desired window mode. Two options are
available: Regular Window and Seamless Window.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt168L. However, if you use a
serial-based barcode scanner, and attach it to your mt168L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a delivered application.
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Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 93 for detailed instructions.

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio

Check/Uncheck to enable/disable sound in an ICA session.

197



198

Configuring Client Settings
Configuring Service Access Settings

Audio Quality

Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.

Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where

bandwidth is plentiful and sound quality is
important.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Low Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.

Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 62 for detailed instructions on these similar settings.
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Settings for the Connection Type of Server Connection

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 175.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 179.

Fore descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 184.

For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 189.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 194.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

This table only provides descriptions for available settings when
Server Connection is selected.

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the XenApp server.

NOTE: Server Connection only supports connections to XenApp servers.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Server Name

Type in the name of the server.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mt168L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection oo Sfter system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “4.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt168L. However, if you use a
serial-based barcode scanner, and attach it to your mt168L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual server desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “4.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 62 for detailed instructions on these similar settings.
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4.6.12 Configuring Basic VMware View Connection Settings

The VMware View setting enables you to configure View connection settings for VMware View or Horizon View
services and create shortcuts on the local desktop and START menu for service access. You can access on-demand
services for work simply through these shortcuts.

=) NOTE
=
« For more information on VMware desktop virtualization solutions, please visit
VMware website at www.vmware.com.

To quickly configure VMware View connection settings, please do the following:

1. On Atrust Client Setup, click Applications > VMware View.

2. The View Connection list appears in the Configuration area.

o Lodl Jledlsad
® Atrust Client Setup N =N | W= | B
l\l:l'l.lSl: Applications User Interface Devices Network System

+ Add H — Delete |

- Remote Desktop
- Citrik ICA
WMware View

Session Name ¥ Connection Server

NOTE

i

- If you haven't created any entry, the View Connection list will be empty.

3. Click Add on the top of the View Connection list to add a new entry of View connection.



EEEES

Atrust

WVMware View

Atrust Client Setup
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Certificate checking mode:

Applications User Interface Devices Network System
General Options SECUREMATRIX
- Server Settings
Session Name: * || | -]
Connection Server: “ | I-.
Port: [ | &
Use Secure Connection(SSL): |‘r‘es ;l I-.

|Warn before connecting to |;| .-

When Connection Ends: [Return to VMware Pool | ._
- Login Settings
User Name: | | I-.
Password: | | I-.
Domain: | | I-.
Desktop [ Application Name: € | | h
\erify before Access: | No ;l I-.
Preferred Display Protocol: [Manual Rd| e

Common Settings

Save l | Cancel

4. Type in the desired session name and the computer name or IP address of the View Connection Server, and

then click Save to confirm.

=)) NOTE
=

« These are the only required fields for the creation of a service access shortcut on the
desktop. Other data can be provided during the period of service access. Depending

on your needs, you might choose to type in more other data.

5. The new entry is added to the View Connection list and the access shortcuts are automatically created

on the local desktop and START menu.

205



206 | Configuring Client Settings

Configuring Service Access Settings

4.6.13 Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Double click the created (customized) access shortcut on the desktop.

NOTE

« A window might appear with a certificate message about the remote server.
Consult the IT administrator for details and ensure the connection is secure first.
To import a security certificate, please refer to section “4.2.16 Importing Certificates
for Remote Computers” on page 71.To bypass, click Connect Insecurely.

=

2. AWelcome window might appear. Click OK to continue.

3. A window appears prompting for the credentials. Enter your user name, password, click the Domain drop-
down menu to select the domain, and then click OK.

Server Login

vmware Horizon

Server: (@ hitps!/AMCSVHVpoc

Username: |\ |

Password: | |

Domain: |VHV | kv |

|gance| || Jolis |

4. A window appears with available desktops and/or applications for the provided credentials.

® VMware Horizon Client =

File  Connection View Help

&% [ bttpsMICS VHVpoC

L @

Adobe Reader XI Calculator LINE Mozilla Firefox

4 o Q N

Notepad Paint Skype W7U

5. Double click to select the desired desktop or application.



Configuring Client Settings | 207

Configuring Service Access Settings

6. The selected desktop or application will be displayed on the screen.

NOTE

(]

- Your desktop or application will be displayed in full screen. You can:

< Click File > Return to Desktop and Application List on the top tool bar to
recall the Desktop and Application list.

WMware Horizon Client Connection ¥ View > Help~ | (O [0 X

4r Disconnect from Server...
\ Return to Desktop and Application List |

o Quit

< Click View on the top tool bar to switch to a virtual desktop or application.

WMware Horizon Client File * Connection ¥ Help» | (2 @ X

Windowed

® Full Screen - This Monitor
Full Screen - All Monitors
Resize |

Adobe Reader

@ Firefox

O LNE

|-l Windows Calculator
= w7u
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4.6.14 Configuring Advanced View Connection Settings

The table below provides a description of each setting item for View connections. Please refer to this table to
configure advanced settings and customize shortcuts on the local desktop and START menu for service access.

General Sub-tab

Server Settings

Item

Description

Session Name

Type in the name for VMware View or Horizon View sessions.

Connection Server

Type in the computer name or IP address of the View Connection Server.

NOTE: For more information on View Connection Server, please visit VMware
website at www.vmware.com.

Port

Type in the port number used to communicate with the View Connection Server.
To use the default value, simply leave it blank.

Use secure connection (SSL)

Check/Uncheck to enable/disable secure connection.

Certificate Checking Mode

Click the drop-down menu to select if to check server identity certificates

and if to connect to untrusted servers. Three options are available: Do not
verify server identity certificates, Warn before connecting to untrusted
servers, and Never connect to untrusted servers.

When Connection Ends

Click the drop-down menu to select what to do when the connection ends. Two
options are available: Return to VMware Pool and Quit VMware Client.

Option Description

When the connection ends, return to the Desktop

Return to VMware Pool and Application list for given credentials.

When the connection ends, close VMware Client.
Quit VMware Client To access virtual desktops and applications, you
need to provide the credentials again.

Login Settings

Item Description

Username Type in the user name for authentication.

Password Type in the password for authentication.

Domain Type in the domain name of the View Connection Server.

Desktop / Application Name

Type in the desktop / application name. Or, leave it blank for users to select one.

NOTE: You can use the Search icon O\g to help you discover available desktops
or applications for a given set of credentials.
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Verify before Access

Click the drop-down menu to select whether to verify the entitlement to the

virtual desktop

or application provided in the previous setting item:

Option Description
Verify the entitlement to the virtual desktop or application
Yes provided in the previous setting item. Stop if the given
credentials do not pass this verification.
If the given credentials are not entitled to the virtual
No desktop or application provided in the previous setting

item, just ignore that error and provide the Desktop and
Application list available for that credentials.

Preferred Display Protocol

Click the drop-down menu to select the desired display protocol. Three options
are available: Manual, Microsoft RDP, and PCoIP.

Option

Description

Manual

Manually select the desired display protocol.

Microsoft RDP

Use Microsoft RDP as the display protocol.

PCoIP

Use VMware PColIP as the display protocol.

Common Settings

Item

Description

Non-Interactive Mode

Select Yes or No to allow or disallow the Non-Interactive mode. The default is to
use the Non-Interactive mode.

Option Description
The Non-Interactive mode is used. Users are not allowed to
Yes re-select different settings if the settings have been specified
in View connection settings.
The Interactive mode is used. Users are allowed to
No re-select different settings even if the settings have been

specified in View connection settings.
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Autostart When Startup

Select whether to open a VMware View or Horizon View session automatically or
not when your mt168L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt168L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
VMware View session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
VMware View or Horizon View session and perform
the configured action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a VMware View or Horizon View session is ended.
Four options are available: Do Nothing, Restart Application, Reboot,
and Shutdown.

Option Description

Do Nothing Returns to the local desktop.

Restart Application Opens a VMware View or Horizon View session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Window Settings

Item Description
Click the drop-down menu to select the desired display size of a View session.
Three options are available: Full Screen, Large Window, and Small Window.
Option Description
Resolution Full Screen Opens the selected View session in full screen.

Large Window  Opens the selected View session in a large window.

Small Window  Opens the selected View session in a small window.

USB Redirection Settings

Item

Description

Mass Storage

Smart Card

Human Interface Device

Printer

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for VMware View Sessions”
on page 64 for detailed instructions on these similar settings.

Microsoft RDP Protocol Only

Item

Description

Printer Mapping

Click the drop-down menu to enable/disable printer mapping when RDP protocol
is used for VMware View connections.

When Enable is selected, users can access a local or network printer in a virtual
desktop session.

NOTE: You need to add a local or network printer for your mt168L first, and then
enable this feature here to use that printer in a virtual desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt168L, please refer to section “4.4.7 Adding a Local Printer” on page
93 or “4.4.8 Adding a Network Printer” on page 96.
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SECUREMATRIX Sub-tab

Connection Settings

Item

Description

Use SECUREMATRIX

Check to use SECUREMATRIX authentication.

GSB Server Address

Type the server address of GSB server, the server for SECUREMATRIX
authentication service.

Username

Type your user name (Login ID).

(]

NOTE

- For details, please refer to “A.3 Using SECUREMATRIX Authentication for VMware
Connections” on page 222.
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4.6.15 Configuring SSH Connection Settings

To configure SSH (Secure SHell) connection settings, please do the following:

1. On Atrust Client Setup, click Applications > SSH.

2. The SSH Connection list appears in the Configuration area.

o Lodl Jledlsad
® Atrust Client Setup N =N | W= | B
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator | + Add H = Delete |

- Remote Desktop
Citrix ICA

- WMware View
S5H

Session Name *  Server Address Connection Type

5/ NOTE

- If you haven't created any entry, the SSH Connection list will be empty.

3. Click Add on the top of the SSH Connection list to add a new entry of SSH connection.
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® Atrust Client Setup A =R e R
l\tl‘l.lSl: Applications User Interface Devices Network System
- Remote Desktop
-~ Citrix ICA - Server Settings
- WMware View Session Name: * || | =
55H -
Connection Server: * | | (=
Connection Type: [ssH M
Port: [22 | &
Username: * | | L.
Save H Cancel

4. Click the drop-down menu to select the desired connection type. Two types are available: SSH and Telnet.

5. Type in the desired session name, the computer name or IP address of the remote server, the user name, and

then click Save to confirm.

6. The new entry is added to the SSH Connection list and the access shortcuts are automatically created

on the local desktop and START menu.

&) Atrust Client Setup
Atrust Applications User Interface

ST ) o

-~ Remate Desktop Session Name % Server Address
“Citrik ICA | e

VMware View ... ISCA bbs.iscabbs.com
] SDF sdf.org

Devices

SCA
- 5DF

Network System

Connection Type

Telnet
S5H
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4.6.16 Launching SSH and Telnet Sessions

To launch an SSH or Telnet session, please do the following:

1. Double click the created shortcut on the local desktop.

2. The SSH or Telnet session starts in the opened window.

Example: SSH Session

Terminal

Eile Edit View Terminal Geo Help

lelcome to the
You are the 11

[30-Jun-14 20:12:16
% full time

Example: Telnet Session

L= Terminal oo O

Eile Edit \iew Terminal Go Help

Own version of Citadel)

Welcome to the I . BBS.

Login as 'Guest' to just look around, or 'bh to create & new account.

lable to you, type <?>
e <l>
in depth, type <h> to enter the

account here,
in mind.
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Appendices

This chapter provides instructions on advanced settings, maintenance, and
upgrade for your mt168L thin client.

A.1 Resetting Your mt168L to the Factory Default

How to restore factory default settings for your mt168L

A.2 Updating Firmware for Your mt168L

Four ways to update firmware for your mt168L

A.3 Using SECUREMATRIX Authentication for VMware Connections
Enabling SECUREMATRIX authentication
Using SECUREMATRIX authentication
Changing Your Password Pattern

A.4 Auto Setup Flowchart

Sequence of actions in Auto Setup mode
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A.1 Resetting Your mt168L to the Factory Default

To reset your mt168L to the factory default, please do the following:

@ WARNING

+ Resetting your mt168L to the factory default will erase all current settings in Atrust
Client Setup and restore all settings to defaults.

1. Restart your mt168L.

1. During the POST (Power-on Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

Atrust Thin Client Menu

Normal Mode
Safe Mode
Reset Mode

Firmware update

Reboot
Shutdown

—1) NOTE

i
« You might need to wait about 15 seconds for this menu to appear on the screen.
- Six options are available on Atrust Thin Client Menu: Normal Mode, Safe Mode,

Reset Mode, Firmware update, Reboot, and Shutdown. See the table below for
the description of each option:

Menu Option Description

Normal Mode Boots up your mt168L as the normal startup procedure.
Safe Mode Clears and resets the current screen resolution setting.
Reset Mode Resets your mt168L to the factory default.

Firmware update  Updates firmware for your mt168L through the network.
Reboot Reboots your mt168L.

Shutdown Shuts down your mt168L.

2. Use arrow keys on the keyboard to select Reset Mode, and then press Enter on the keyboard to continue.

3. A message appears prompting for confirmation. Click y on the keyboard to confirm.

4. After completion, press Enter on the keyboard to restart your system.
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A.2 Updating Firmware for Your mt168L

Four ways are available to update firmware for your mt168L:

Method Description
Atrust Thin Client Menu  Downloads firmware from a remote computer and updates firmware for your thin client.
USB Flash Drive Updates firmware with a USB flash drive created by Recovery USB Disk Creator.
Atrust Client Setup Initiates firmware update locally on the thin client with the help of Atrust Client Setup.

Atrust Device Manger Initiates firmware update remotely on the remote computer with Atrust Device Manager.

Using Atrust Thin Client Menu

To update firmware using Atrust Thin Client Menu, please do the following:

1. Connect your thin client to the network, and then restart it.
2. During the POST (Power-On Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

3. Select Firmware update and then follow the on-screen instructions to complete the task.

NOTE

+ You need to specify the IP address of the firmware server over the network. A
firmware server is the server where Atrust Device Manager is installed and client
firmware files are imported through Atrust Device Manager.

W)

« For more information about Atrust Device Manager, please refer to the User’s
Manual for Atrust Device Manager.

Using a USB Flash Drive

To update firmware using a USB flash drive created by Recovery USB Disk Creator, please do the following:

NOTE

(alll |

- Forinstructions on how to create a USB flash drive using Recovery USB Disk Creator,
please refer to the Quick Guide for USB Creator.

1. Plug the USB flash drive, and then restart your thin client.
During the POST period, press F7 to enter the Boot Device menu.

Select the USB flash drive on that menu to enter Atrust Thin Client Recovery System screen.

> W

Follow the on-screen instructions to complete the task.
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Using Atrust Client Setup

To update firmware using Atrust Client Setup, please refer to section “4.2.7 Updating Firmware from the
Management Computer” on page 54.

Using Atrust Device Manager

To update firmware using Atrust Device Manager, please refer to the User’s Manual for Atrust Device Manager.
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A.3 Using SECUREMATRIX Authentication for VMware Connections
Enabling SECUREMATRIX Authentication for Custom VMware Connections

To enable SECUREMATRIX authentication for a custom VMware connection, please do the following:

NOTE
- SECUREMATRIX authentication is not available in Quick Connection mode.

&

1. On the local desktop, click START > Settings > Atrust Client Setup to launch Atrust Client Setup.
2. Click Applications > VMware > Add to create a new entry of connection settings.

3. On the General tab, type the desired session name and the server address of View Connection Server.

: Lol dlalisal
® Atrust Client Setup o Lol
Atl'l.lSt Applicati User Interf: Devices Network System
General Options SECUREMATRIX
-~ Remote Desktop
o Citrix ICA - Server Settings
= WMware Wiew Session Name: * |VHV5 ‘ [
S5H Connection Server: * |VCS.V1—Mpoc ‘ e
Port: [ | &
Use Secure Connection(SSL): [ves hd I
Certificate checking mode: [Warn before connectingtor ~]
¢ Login Settings
User Name: | ‘ e
Password: [ =
Domain: [ | &
Desktop / Application Mame: < | E
Preferred Display Protocel: [Manual -l e
¢ Common Settings
Non-nteractive Mode: [ves 1&
Autostart When Startup: [Mo -] =
On Application Exit: | Do Nothing ;l e
Save l | Cancel

4, On the SECUREMATRIX tab, click to check Use SECUREMATRIX.
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B S HHHEE R HHHHHHHSSS SIS
®) Atrust Client Setup o ol
Atrust Applications  User Interface Devices Network System

General Options SECUREMATRIX
- Remote Desktop
- Citrix ICA - Connection Settings
- VMware View .__ Use SECUREMATRIX

WHVE
- SSH

Save H Cancel |

% NOTE

- By default, SECUREMATRIX authentication is disabled.

5. Two fields appear for you to provide SECUREMATRIX related information. Type the server address of GSB
server (the server for SECUREMATRIX authentication service).

- Connection Settings
L« Use SECUREMATRIX

GSB Server Address: + [192.168.0.77 | &

Username: | | L

6. Configure other connection settings if needed, and then click Save to confirm.

7. The access shortcuts will be created on the local desktop and START menu.
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Using SECUREMATRIX Authentication in VMware Connections

When SECUREMATRIX is enabled in your VMware connection, follow the steps and instructions below to use
SECUREMATRIX authentication:

1. Click the shortcut on the local desktop or START menu.
2. A window appears to prompt for the Login ID of SECUREMATRIX authentication.

i) Login

Login ID

( Change Password

3. Type your Login ID, and then click OK to confirm.

% NOTE

+ To change your password pattern, click Change Password. For details, please see
“Changing Your Password Pattern for SECUREMATRIX Authentication” on page 227.

4. The SECUREMATRIX window appears prompting for the password.

SECUREMATRIX

SECUREMATRIX

(7Jla)lz)e]) [e)(s](s])le) [2)(s)(z)(2) (z)[z](e]1]
[4)l7)ls)(e] [e)(e]lo])(s) [a)(7]()[2] [oJ[7](s](3]
s)lsl(z)la) [)s]le)ln) (3)(s)lz)le) [n)la](4](e]
[4)(s](z)s] [o)(z](s])lo] [s](s]lz)[s] (ell=](e](z]

Authentication

Password [ l

5. Type numbers under your password pattern using the keyboard or click numbers directly on the window,
and then click OK to confirm.
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- For example, if your password pattern is shown as below, type or click numbers,
0,0,4,51,3,6,2 insequence.

(ells)(s)e) [2)(s]07)(z]) [2)(2](o](2]
[e)ls)l2)(s] [a)x)(a)r) [eJ()(o)(=]
[2)(s)a)7) [=l(s)z)le]) [)(a](4](e]
[o)(2](s]e) [o)(s](7)(s]) [e)l=](e](1]

6. A message appears when SECUREMATRIX authentication is completed. Click OK to continue.

Motification from SECUREMATRIX
Last Login Timestamp : 2015-11-16
05:56:33

7. A message appears prompting to provide credentials for access to VMware virtual desktops and applications.
Click OK to continue.

No credentials, please enter,

User o [ ]
Password * [ ]
Domain e [ v]

9. The Desktop and Application list appears. Double-click to select the desired desktop or application.
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File Connection Wiew Help

[ ossmsnmec

Adobe Reader XI Calculator

4 )

Notepad Paint
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Skype

Mozilla Firefox

[ |
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Changing Your Password Pattern for SECUREMATRIX Authentication
To change your password pattern for SECUREMATRIX authentication, please do the following:

1. On the window prompting for the Login ID as shown, type your Login ID, and then click Change Password.

Login ID [ |

( Change Password )

2. Type or click numbers under your old password pattern, and then click OK to continue.

SECUREMATRIX |

SECUREMATRIX

7Jls)lz)(e) [e)(s]ls]le) [2)(s]lz)(2]) (z)(2](s](1]
4)l7)le)le] [e)le]le])ls) [a)l7)l3)(2]) (o)(7](s](3]
(s)lells)la) [1)is]le)ln) [3)(slz)le) (7)la])l4](e]
[4)ls)l2)(s] [oJ(2]ls])le] [s](s]lz)ls) Lello]le](z]

Authentication

Password [ l

3. Type or click numbers under your new password pattern, and then click OK to continue.

SECUREMATRIX —
Your new SECUREMATRIX
e | FOEE BEEE @EEE

(2){s](5)(3] [7)z][e](7] [e][3](8][3]
(3){a)lo]2] [s)(7](e][2] [e][4](z][7]
[7){2](2]{3] [z](e][3][e] [e][e](2](2]

Authentication

Mew Password [ l
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4. Type or click numbers under your new password pattern again, and then click OK to continue.

SECUREMATRIX e

SECUREMATRIX

g7 l(3)(2)(2] [e](z]la]le] [2](2][2][2] [e][4](5](6]
flis](2)(s] [e](7])lel(s] [2](s)(s][z] [e][2](5](e]
[lellell2] [e][a]lal2] [2](4][3][2] [e][7](7](5]
lel(sfi[2](4] (6]{4][e]e] [2][7][0](e]

Authentication

Confirm Passward [ l

5. A window appears showing your new password pattern in numerical order and prompting for confirmation.
Click OK to confirm.

SECUREMATRIX

8
7
6
5

Bl W NP

Confirmation
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A.4 Auto Setup Flowchart

Please see next page for sequence of actions in Auto Setup mode.

For details, please refer to User’s Guide for Auto Setup.



START

Power on / Restart
thin client

Auto Setup
enabled

Network
connected

Auto Setup
environment
ready

Get preset
configurations &
Apply basic
Global and MAC *
configurations

User
authentication
enabled

Yes

User
authentication
passed

Deny access

FLOWCHART

Unportable thin clients start with
Quick Connection screen

Portable thin clients
start with
Local Desktop

No Factory default
configurations ® © © © ¢ ¢ ¢ ¢ o o o
No
Logon screen with
guest-enabled
No got and kept user authentication
—_— Global and MAC

configurations Enter your Credentials

Yes
oo vsemarms: (I
Apply previous ° < [
configurations o
‘ . account name tg
® .
No Logon screen with
' g guest-disabled
° user authentication
- Enter your Credentials
[ ]
e o o
[ ]
[ ]
* MAC configuration will be applied if any L]
. [ ]
but not a necessary element in Auto Setup;
Global one is required. ° g
° Logon screen with
L Active Directory
ady for use ° - authentication
T ° L Enter your Credentials
[ ]
[ ]
No Apply complete (1]
— » | Globaland MAC * L
configurations ° iy
[ ]
e 6 6 6 6 o6 o o o o o
Yes Apply complete
configurations )\

When Auto Setup is enabled, user environment might
vary with preset configurations.

AUTO SETUP REQUIREMENTS

* Auto Setup enabled endpoint devices

* Auto Setup environment and mechanism
*  Network connectivity

» Target virtualization services for use
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Specifications

Atrust mt168L mobile thin client

Processor Intel® Celeron® N2807, Dual-core, 1.58 GHz
System Memory 2GBDDR3

Flash Memory 4 GB eMMC (Optional: 8/16 /32 /64 GB)
DiSPIa)I Type: 11.6” 16:9 Glare

Maximum Resolution: 1366 x 768
Color Depth: 18-bit (262,144 color tones for each RGB color)

Keyboard / Touchpad Keyboard: 87 keys
Touchpad: 2-button Glide pad
Sound Built-in speakers
|/O interfaces Leftside: Right side: Display and base:
1xVGA 1xDCIN 1 x RJ-45 2xUSB2.0 1 x Built-in microphone
1xUSB 3.0 1xSD card slot (optional) 1 x Microphone port 1 x Webcam (optional)
1x Headphone port 2 x Built-in speaker
Networking 10/100/1000 Mb Ethernet
Wi-Fi 802.11 a/b/g/n
AC Adapter INPUT: 100-240 V, ~2.5 A, 50-60 Hz
OUTPUT: 19V, 2.1 A, 40 W
Battery Pack Rechargeable lithium-ion battery
11.1V, 2800 mAh, 31 Wh
Operating system Atrust Linux
Su pported Protocols Microsoft RDP with RemoteFX / Citrix ICA with HDX / VMware PColP
Man agement Atrust Client Setup / Atrust Device Manager
Security Kensington security slot
Dimensions (W)295 x (D)192 x (H)32 mm
Weight 1.10 kg (approx.)
Environment Operating Temperature: 0°C~35°C
Non-operating Temperature: -30°C~60°C
Operating Humidity (Rh): 10% ~ 90% (non-condensing)

Non-operating Humidity (Rh): 5%~ 95%
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